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INTRODUÇÃO 
Agradecemos por escolher o WINLIVE da Promusicsoftware, o primeiro programa para o 
gerenciamento do repertório musical com funções específicas de karaokê, cuja primeira versão 
remonta a 6 de novembro de 1994. O desejo de seu criador Leonardo Di Pinto era incluir um 
solução a possibilidade de usar arquivos diferentes e, acima de tudo, gerenciá-los de maneira 
simples e imediata. A versão WINLIVE PRO SYNTH 10, disponível para Mac OSx e Windows, foi 
projetada para uso profissional e, com a atualização mais recente, tornou-se uma das versões mais 
apreciadas, mesmo entre aqueles que praticam a profissão de cantor e animador e exigem um 
programa estável para o gerenciamento de seu repertório musical, compatibilidade e 
versatilidade, mas acima de tudo com instrumentos adequados para um uso cada vez mais "ao 
vivo" de suas performances. 
Muito apreciado também por todos aqueles que são entusiastas do karaokê e querem 
personalizar suas performances 
A versão PRO SYNTH é uma das versões comerciais do WINLIVE, portanto é proibida a sua 
transferência para terceiros, a cópia ilegítima da licença e quaisquer ações de hackers relacionadas 
ao software. 
A implementação da Engenharia Reversa, a modificação do código e os recursos gráficos, bem 
como a reprodução parcial de seus arquivos são proibidas e podem ser processadas de acordo 
com a lei. 
Nenhuma responsabilidade é assumida pelo uso inadequado do programa e / ou danos ao sistema 
operacional ou perda de dados.  
 
Para saber mais, visite nosso site: 

 www.promusicsoftware.com 

 
WINLIVE é uma marca comercial da Pro Music Software  
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INSTALAÇÃO E REQUISITOS 
Para instalar o WINLIVE, basta executar a instalação e continuar seguindo as instruções na tela. 
Normalmente, no final da instalação, o programa exige a entrada de dois dados: PERSONAL 
ACCOUNT e SERIAL NUMBER enviados por email, se o programa foi comprado on-line ou em 
papelão incluído no pacote, se comprado em uma de nossas lojas. 
Você pode escolher o modo de demonstração se não tiver a licença para descobrir todas as 
funções do Winlive. O uso da versão DEMO, embora limitado ao gerenciamento de 20 faixas, é 
expressamente proibido em público. Claramente, a versão COMPLETA não tem restrições. 
Para ativar o programa, no entanto, é necessária uma conexão à Internet a partir de um 
dispositivo conectado à rede, mesmo que não seja adequadamente do próprio PC onde o WINLIVE 
será instalado. 
Se o seu computador estiver conectado à Internet: 
Insira PERSONAL ACCOUNT, SERIAL NUMBER e todos os dados necessários 
Um ID COMPUTER aparecerá e, finalmente, clique em ATIVAR SUA CÓPIA AQUI; 
 
Se o seu computador não estiver conectado à Internet: 
Instale a configuração do programa e digite PERSONAL ACCOUNT,  SERIAL NUMBER e todos os 
dados necessários. Neste ponto, um ID COMPUTER aparecerá: 
de qualquer local conectado à Internet, conecte-se ao nosso site: 
www.promusicsoftware.com 
Seção Ativações insira PERSONAL ACCOUNT e SERIAL NUMBER para inserir seu perfil pessoal. 
Digite NEW ACTIVATION e insira o ID COMPUTER gerado pelo programa. Um número de licença 
será exibido abaixo, que deve ser copiado na seção apropriada do programa no PC. 
 
ASSISTÊNCIA REMOTA GRATUITA (usuários das versões WINLIVE PRO 10 / WINLIVE PRO SYNTH 
10) e YOUTUBE SERVICE até fevereiro de 2021 são garantidas 
 
Veja o tutorial em vídeo sobre a instalação do programa 

https://youtu.be/KY4lNKBAdAk 

 
* Configuração recomendada do Windows: RAM de 2 GB, espaço livre de 200 Mb em HD, CPU i3 ou superior 
* Configuração recomendada para Mac: 3Gb Ram, 1200 Mb de espaço livre em HD, CPU i3 ou superior 
 
* Compatível com Windows 7, Windows 8 / 8.1 e Windows 10 de 32 e 64 bits 
* Compatível com Mac (testado até Catalina) 

 

Observe: a configuração recomendada garante que o programa funcione e seja executado, mas os efeitos gráficos 
podem precisar ser desativados para obter maior desempenho, o que pode ser significativamente reduzido ao 
reproduzir arquivos CDG ou VIDEO. 
 
O programa também pode funcionar com versões anteriores do Windows, mas não garantimos o seu correto 
funcionamento. 
* na configuração recomendada, o início do programa pode ser mais lento devido à troca para HD e à lentidão do 
processador. 
* Alguns programas antivírus podem retardar consideravelmente o lançamento do programa. Se isso permanecer no 
Check Antivírus por um longo tempo, desative temporariamente o antivírus. 
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FUNCIONALIDADE 
WINLIVE PRO SYNTH não é apenas um programa de Karaokê, mas também um poderoso 
reprodutor e gerenciador de arquivos multimídia. Através do programa é possível gerenciar em 
tempo real a reprodução dos arquivos mencionados, exibindo o texto e os acordes sincronizados 
que podem estar contidos nos arquivos de maneira simples e clara. Você pode sincronizar 
facilmente letras e acordes com arquivos que não os contêm. 
O WINLIVE PRO SYNTH gerencia até um máximo de 42 escadas, das quais SONGLIST chama 39 no 
database, 1 temporário (F10) e 2 listas de pastas de músicas (F11 e F12 para uploads externos fora 
do database). 
É possível controlar vários parâmetros de um arquivo de música, iniciar e parar, alterar o 
andamento, o tom (qualquer formato de áudio e vídeo) e, para alguns arquivos, variar os 
instrumentos, volumes, pan, etc ... até as notas individuais da bateria tudo em tempo real! 
Grande melhoria na audição de Midifiles graças ao nosso sintetizador de software (Winlive Synth 
Orchestra) inserido no programa, permitindo um som muito real e impactante. 
Além do modo tradicional (database), o modo Media Explorer foi aprimorado nesta versão, que 
permite gerenciar arquivos diretamente do HD ou da unidade externa, evitando importá-los para 
o database. Recomendamos esse modo exclusivamente para quem faz karaokê e gerencia dezenas 
e dezenas de milhares de arquivos, limitando-se ao gerenciamento da chave e à reserva do 
arquivo pelo cantor de plantão. 
 

Aconselhamos nossos usuários a não usar cópias ilegais do software, lembrando 
que não é apenas uma ofensa criminal que possui o software sem várias registro, 
mas que o mesmo software pirata contém perigosos e difíceis de bloquear vírus e 
cavalos de Tróia 

Lembramos, no entanto, todos os usuários registrados do WINLIVE PRO SYNTH 10 que têm direito a assistência 
remota gratuita com a qual um de nossos operadores poderá interagir diretamente com o PC do usuário e, assim, 
demonstrar as inúmeras funções do Winlive no "campo". Embora a assistência remota seja um serviço fornecido por 
várias empresas, muitas vezes possui um custo considerável, enquanto o oferecemos totalmente gratuito. É um dos 
serviços mais apreciados pelos nossos usuários. 

Lembramos que a assistência remota, como os serviços do YouTube, é dedicada exclusivamente àqueles que possuem 
a versão atualizada mais recente e, portanto, não são fornecidos nas versões anteriores. Reiteramos que os serviços 
de ASSISTÊNCIA REMOTA GRATUITA e YOUTUBE estão ativos para esta versão até o final de fevereiro de 2021 
Portanto, recomendamos que você sempre atualize para a versão mais recente para acompanhar as inovações 
contínuas do Winlive 
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Principais características do WINLIVE PRO SYNTH 10 
(em negrito as notícias em comparação com a versão anterior) 

Seção PLAYER 
Reprodução de arquivos multimídia (midi, kar, mp3, mp3 + lrc, wav, cdg, cdg-zip, avi, mpg, mp4, flv, wma, lrc, txt, rtf, 
jpg, gif, bmp, ytb YouTube, pdf) 
Funções que podem ser acessadas com teclas rápidas, limitando o uso do mouse 
Gerenciamento de alterações de matiz para arquivos Midi, Áudio e Vídeo 
* Gráficos renovados, novos ícones e funções inovadoras que podem ser acessadas diretamente com as teclas 
* Rolagem de texto (apenas para a versão Windows) 
* Imagens como fundo em movimento podem ser recuperadas aleatoriamente, mesmo a partir de uma pasta de 
imagens 
* Nova biblioteca de sons (apenas para a versão Synth) 
* Nova função do Media Explorer 
* Pesquisa ultra-rápida no Media Explorer, mesmo entre centenas de milhares de arquivos 
* Criação de listas personalizadas com salvamento no Media Explorer 
* Exibir proprietários com descrição 
* Gerenciamento rápido de database 
* Seleção de arquivos duplicados com novas funções dedicadas 
* Capacidade de ampliar arquivos PDF para visualização adequada no monitor 
* Novas funções do YouTube com controles de avanço / retrocesso / parada etc. 
* Economia física de midi revisitada com a possibilidade de inserir volumes em formato fixo 
* Equalizador gráfico no Synth interno 
Editor de eventos para associar eventos específicos a arquivos midi, áudio e vídeo 
Editor de ícones rápido com novas funções 
Mixagem de áudio também com arquivos de vídeo 
Importação de listas de reprodução VanBasco com parâmetros-chave, canais mudos etc. 
Modo Winlive Dj Control com reconhecimento BMP para arquivos de áudio com efeitos em tempo real 
Metrodrummer (bateria eletrônica com ritmos predefinidos) com possibilidade de sincronização com os midifiles 
Estilo de remix Midi usando uma biblioteca com mais de 220 ritmos 
* Novos ritmos disponíveis 
Capacidade de substituir facilmente o ritmo de um midifile e salvá-lo no database 
Editor de pan para arquivos de áudio e vídeo 
Função MPX para arquivos de áudio com faixas divididas em esquerda e direita 
* Escada de fundo com partida automática em momentos de pausa e configuração de segundos para esperar 
Gravação de áudio em Midi e Áudio 
Visualização para o arquivo de áudio no segundo dispositivo 
Editor de mixagem avançado com no máximo 5 padrões diferentes que podem ser acessados em tempo real 
Reserva instantânea com desvanecimento ou mixagem entre músicas de áudio e midi 
Efeitos de inserção em tempo real para faixa ou gravação principal e secundária (áudio) 
Possibilidade de combinar um midi com um áudio e vice-versa ou 2 faixas de áudio 
Exportação de músicas de áudio com uma segunda faixa de áudio (por exemplo, segunda faixa de gravação) 
Suporte para monitor duplo (monitor de karaokê) também para arquivos de vídeo e cdg 
* Monitor de clone do monitor principal ou monitor de karaokê 
Barra de visualização da melodia 
Função integrada de reparo / instalação de codec de vídeo 
Rolagem de gerenciamento de legendas no Karaoke Monitor 
Database para catalogar arquivos e configurações relacionadas também para critérios de "tempo" 
Pesquisa órfã em profundidade 
Pesquisa automaticamente arquivos ausentes em pastas e subpastas de PC 
* Destaque de ausentes (arquivo ausente) já no SongList 
Editor de som do usuário para criar novos bancos de som 
Editor de drumkit do usuário para criar novos drumkits 
Editor de amostras de áudio para inserir até 100 amostras em tempo real 
Gerenciamento de volume, efeitos, timbre, ressonância, transposição, sustentabilidade, etc. para cada faixa midi 
Armazenamento físico ou virtual de alterações feitas nos arquivos 
Gerenciamento de até 16 dispositivos diferentes para o midi 
Importação de texto em formato TXT, RTF, PDF (modo atril eletrônico) 
Suporte para tablets Windows no modo retrato (vertical) 



 5

Vários métodos de exibição de karaokê também diferem no monitor de karaokê 
Exibir acordes no texto 
* Atribuição da melodia a qualquer canal midi (canal midi padrão 4) 
Possibilidade de editar as notas individuais da faixa de bateria 
Possibilidade de associar um texto, pdf ou imagem a uma música Audio ou Midi 
Inserindo textos e acordes para Midi e Áudio (armazenados nas meta tags do arquivo) 
Compatível com o formato de karaokê SongService (M-live) 
Leitura de MP3 com acordes SongService (M-live) 
Gravação física completa de MP3 e WAVE 
Além dos acordes e do texto, também será possível salvar outros parâmetros (volume, afinação, equalização, ganho, 
MFX etc.) 
Salvando texto de karaokê em MP3 também no formato SYLT (compatível com players habilitados) 
Salvando arquivos de vídeo no formato de áudio (wav ou mp3) 
Conversor Wave para Mp3 
Motor de busca sofisticado com critérios diferentes também para a velocidade da música 
Extração e conversão de CD para mp3 ou wave 
Compressor de volume para arquivos de áudio e Midi 
Botões de "ícones rápidos" de desempenho para acesso imediato às várias seções 
Inserção de 10 markers para cada música 
Inserção de letras e acordes para arquivos Midi e Mp3 
Inserindo imagens como plano de fundo 
Função Cover para variar a sensação dos midifiles 
Parâmetros gerais de volume, compactação e ênfase no mecanismo de áudio 
Importação do Groove tanto midi quanto áudio 
Estrutura detalhada do localizador com inserção de textos, imagens, loops, mudança de tom de salto em pontos 
específicos 
Exibição de pontuação e notas simplificadas em arquivos médios 
Reconhecimento automático de acordes a partir de arquivos midi 
Exibição de notas no teclado do piano para uso educacional 
Capacidade de concatenar vários bancos de dados 
* Aplicativo WINLIVE REMOTE CONTROL para controlar remotamente as principais funções do Winlive (disponível 
nas próximas atualizações gratuitas) 
* Dezenas de novos recursos sugeridos por nossos usuários 
* Renove os recursos do YouTube disponíveis apenas para as versões da série WINLIVE 10 
* Assistência remota gratuita (disponível apenas para as versões WINLIVE PRO 10 e WINLIVE PRO SYNTH 10) 
Intuitivo, funcional e com desempenho 
 
Seção SYNTH (SYNTH ORCHESTRA) 
* Novo banco de som interno de 96 MB GS / GM + de alta qualidade (sons SFX incluídos) 
* Tabela de ondas de 96 MB composta por 27 DrumKits e 333 sons instrumentais 
Novos sons com desempenho cada vez maior para aumentar a qualidade de seus arquivos médios cada vez mais 
Implementação de drivers WASAPI de baixa latência 
É possível tocar com um teclado midi de baixa latência conectado diretamente ao PC (MIDI IN) 
Piano digital Winlive com sintetizador de 4 partes 
Gerenciamento de drivers ASIO de baixa latência 
Convertendo songs midi para wave ou mp3 com as letras e acordes incluídos 
Parâmetros gerais de volume, compactação e ênfase no mecanismo midi 
Gerenciamento do efeito de atraso para cada faixa midi 
Gerenciamento de efeitos múltiplos nos sons do Synth interno com mais de 20 MFX selecionáveis para cada faixa midi 

* Notas para a versão Mac: algumas funções em computadores Mac podem diferir ou não ser comparadas à versão 
Windows PC (principalmente rolagem de texto, acoplamento de efeitos a sons, execução de músicas do YouTube 
externas ao programa) 

Para cada licença, você receberá, por e-mail, os códigos de ativação do programa. 
Até 4 ativações podem ser usadas para cada licença também em computadores diferentes (Windows ou Mac) 

Nota: se você substituir ou formatar o disco rígido, uma ativação será perdida
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MÉTODO DE USO 
Descrição geral 
Através do menu de visualização, é possível escolher o modo de operação do programa: 
Performance: (no início do programa) é o modo de reprodução através do qual você pode verificar 
as várias listas de músicas da lista de músicas, organizar as reservas de músicas, verificar a 
performance, o mixer e o karaokê;  
Modo de Edição: este é o modo no qual você pode editar os vários parâmetros das músicas, 
letras, acordes e markers; 
Media Explorer: esse é o modo significativamente aprimorado no qual é possível explorar os 
discos rígidos e possivelmente reproduzir os arquivos encontrados em tempo real, sem precisar 
inseri-los no database; 
Faixas de acompanhamento Online: permite a exibição e o desempenho das faixas de 
acompanhamento pela empresa Recisio (versão karaokê). Visualização da faixa de apoio 
disponível antes de qualquer compra; 
Database: é o modo de programação de músicas. 
O database controla os caminhos das músicas, seus parâmetros, alterações e o arranjo de 
quaisquer imagens de fundo, textos ou pdfs associados a cada música; 
Piano Digital Winlive: : está disponível um sintetizador de 4 partes com o qual (com cartões 
apropriados de baixa latência) é possível tocar em tempo real através de um teclado musical 
externo; 
Metrodrummer:  bateria eletrônica com mais de 220 ritmos predefinidos, com possibilidade de 
sincronização com os midifiles ou pode ser usada sozinha como bateria eletrônica de mesa; 
Winlive DJ Control: seção com modo típico de DJ com reconhecimento de BPM para arquivos de 
áudio em tempo real e várias ferramentas disponíveis; 
Músicas do YouTube: seção em que você pode procurar arquivos de vídeo diretamente no 
YouTube e, eventualmente, inseri-los na sua SongList (siga as condições de uso do YouTube). 
Claramente, este modo requer uma conexão com a Internet. 
Lista de músicas do YouTube:  é uma seleção, atualizada semanalmente, de links para as faixas do 
YouTube. Este modo também requer uma conexão à Internet e para aceitar as condições impostas 
pelo YouTube 
Gerenciamento de eventos: esta função permite inserir eventos, sons ou funções em associação 
com um arquivo midi, áudio ou vídeo. Por exemplo, é possível inserir, em um ponto específico da 
peça, uma alteração de tonalidade, uma imagem ou pdf, uma amostra, uma alteração de página 
de um pdf e assim por diante, para que você possa personalizar ainda mais sua apresentação 
musical. 
 
O Winlive é, portanto, orientado para o imediatismo durante a execução das músicas, que podem 
ser acessadas simplesmente selecionando a lista à qual elas pertencem com as teclas de função, 
seleção e envio. 
A principal tarefa do intérprete será inserir as músicas no database, variar sua tonalidade, volumes 
ou faixas para excluir de acordo com o caso e, possivelmente, ouvir a prévia. Os recursos da versão 
Professional também permitem inserir letras, acordes, markers, variar instrumentos musicais, 
verificando todos os vários parâmetros. 
Uma vez no palco, essas configurações permanecerão praticamente salvas para sempre e apenas 
inicie as músicas para poder cantá-las ou reproduzi-las tocando os arquivos e o karaokê com os 
parâmetros definidos anteriormente. 
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É possível entrar no modo Database através do menu Database  e em Database ou 
pressionando as teclas CTRL + ALT + D. Fechar o database retorna ao modo Perfomance. O Winlive 
também inclui a possibilidade de selecionar arquivos do disco rígido, clicando no menu Arquivo / 
Carregar Arquivo, chamando Carregar Arquivo com o botão direito na tela do Karaokê ou 
simplesmente arrastando os arquivos de uma pasta no PC para a tela do modo Performance. 
Ao arrastar mais arquivos, eles serão exibidos em uma SONGLIST específica associada à tecla F10 
do PC ou recuperada por uma opção numérica para sistemas Mac. 
 
Também existe a possibilidade de definir 2 pastas separadas, que podem ser recuperadas de F11 e 
F12 (Lista de pastas de músicas), associando-as a pastas de PC para desenhar todos os arquivos 
contidos e compatíveis. 
Essa associação é ideal para quem deseja gerenciar bancos de dados de fontes externas (por 
exemplo, sticks) sem importá-los para o database. 
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MODO DE PERFOMANCE 
Abaixo está o diagrama da tela "Perfomance" do WINLIVE PRO SYNTH 10 
 

 
 
 
O SongList 

O SongList é o "coração do programa" acessível através das teclas de função ou  
O título da música (conforme definido no database) e o tipo ou o tipo de arquivo destacado por 
uma cor de reconhecimento bem definida serão mostrados na grade. 
As músicas que contêm um texto são identificadas pelo ícone. . 
A seleção pode ser feita com as teclas do cursor (as 4 setas) no teclado ou com o mouse. 
As listas de músicas (ou listas de reprodução) são 39 no total e podem ser acessadas com as teclas: 

 Para Windows 

 from F1 to F9 (da escada 1 a 9) 

 Shift + [ from F1 to F10 ] (da escada 11 a 20)  

 Ctrl + [ from F1 to F10 ] (da escada 21 a 30) 

 Shift + Ctrl + [ from F1 to F10 ] (da escada 31 a 40) 
 

 Para Mac 

 Pressione a tecla "?" e insira o número da escada (da escada 1 a 40)  
 
Além disso, é possível definir listas de músicas especiais: 
- F10 (SongList temporário) é possível adicionar as músicas das outras listas de músicas com a tecla 
‘INS’ ou com o botão direito do mouse e ‘add to F10’ 
- F11, F12 (lista de pastas de músicas) é possível adicionar todos os arquivos de uma pasta a uma 

das duas listas, para definir a pasta, pressione o teclado '' \ 'ou  
A combinação das teclas Shift + F11 ou Shift + F12 no teclado permite visualizar todo o database 
em uma única lista de músicas grande 
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A tecla BACKSPACE ou  abre a barra de pesquisa (figura abaixo) 

 

 
A pesquisa pode ser feita no único SongList ou em todos (marcando "All SongLists") 
É possível rolar a pesquisa em diferentes ocorrências da SongList usando a tecla "TAB" do teclado. 
Por exemplo, uma pesquisa por "CIAO" encontrará "Ciao mare", "O bella ciao" etc. a seguir. 
Se o autor e o intérprete estiverem definidos no database, podemos filtrar a programação 
exibindo apenas determinados autores ou intérpretes. Para exibir a lista completa, clique em 
"ALL" 
Agora é possível pesquisar no database inteiro pressionando simplesmente as teclas "Shift + F11" 
ou "Shift + F12" no teclado ou visualizar o database inteiro. 
No menu suspenso, podemos selecionar o tipo de arquivo a ser pesquisado (midi, áudio, vídeo). 
Além disso, é possível visualizar e filtrar apenas algumas músicas que atendem a determinadas 
condições: por exemplo, se digitarmos o texto "WAY" e pressionar o botão "Title", poderemos ver 
apenas as músicas que contenham a palavra "WAY" 
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 MENU POPUP 

 
Ao clicar com o botão direito do mouse na tela principal do Winlive, é possível abrir um menu pop-
up, no qual é possível acessar várias funções: 
 

 Carregar arquivo: leia arquivos em tempo real sem inseri-los no database; 

 Salvar arquivo: salvamento físico do arquivo (consulte a seção dedicada); 

 Gerar livro de músicas (letras e acordes): um arquivo com letras e acordes é gerado; 

 Gerenciamento de eventos: habilite a função Gerenciamento de eventos para associar 
eventos a arquivos midi e de áudio. Esta função gera um arquivo associado à extensão * .wen 

 Pasta: : acesso rápido às listas de pastas de músicas (F11 e F12); 

 Tela cheia: exibe a tela principal em tela cheia; 

 Normal: restaura a exibição com menu e barra de controle; 

 Minimizar: a imagem Performance é fechada como um ícone; 

 Tamanho da janela: permite reduzir o tamanho da janela; 

 Modo Karaokê: permite escolher diferentes modos: karaokê com rolagem multilinha, clássico 
(2 linhas), estilo moderno (4 linhas), modo de suporte para partitura, suporte para partitura com 
acordes, suporte para partitura com 6 linhas, 2 linhas acima (estilo de músico) ou sem karaokê ; 

 Aumentar fonte: permite aumentar o tamanho da fonte; 

 Reduzir fonte: permite diminuir o tamanho da fonte; 

 Fonte: permite alterar o tipo, estilo e tamanho da fonte; 
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• Monitor de karaokê: permite ativar o segundo monitor (consulte a seção dedicada); 
• Modo Monitor de karaokê: permite escolher o modo de exibição do monitor e o tamanho da 
fonte; 
• Monitor de clone: ativa e desativa um monitor de clone do monitor principal ou do monitor de 
karaokê; 
• Não insira a lista 'SIAE'; (evite inserir a música na lista de músicas executadas); 
• Bloquear teclado (CTRL + S): escolhendo esta função, as teclas ficam inativas; pressionando 
uma tecla de função, o teclado começa a funcionar novamente; 
• Stop-Panic: interrompe a reprodução dos arquivos e reinicializa qualquer expansor; 
• Importar para database: importe uma música diretamente para o database. 
• Início do YouTube: defina um ponto de partida para a música vinculada ao YouTube
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A BARRA DE CONTROLE 

 

 
 
A barra é dividida em 4 partes, a parte esquerda (barra de transporte) é reservada para as teclas 
de controle da música, a segunda parte está relacionada à música que está sendo tocada 
atualmente (música principal), a terceira parte da música que foi reservado (próxima música). 
A quarta parte consiste em uma série de botões rápidos para acessar as várias funções e modos de 
ÍCONES RÁPIDOS (esses botões rápidos podem não ser exibidos se a resolução do monitor não 
permitir que você faça isso: por exemplo, netbooks ou notebooks pequenos) 
 
Através das teclas localizadas na barra inferior, é possível controlar: 
O canal da melodia (ativado ou desativado) para o midi; 
O andamento em BPM comparado ao andamento original para o midi; 
A mudança no tom dos arquivos midi, de áudio e vídeo. 
  
Depois de definir o andamento e a afinação personalizados (também para o volume e outros 
parâmetros que podem ser controlados pelo Mixer - consulte a seção dedicada), você pode salvar 

esses parâmetros virtualmente no database pressionando o botão na parte superior. 
Portanto, toda vez que o arquivo editado for iniciado, ele será executado com todas as alterações 
feitas e os dados serão mantidos mesmo após a saída do programa 
 
Ao clicar no título ou no intérprete, você pode acessar a funcionalidade Edição rápida. 

  
Esta função permite a edição rápida dos campos Título, Intérprete e Autor e também é possível 
alterar a SongList pertencente. 

Usando o botão  , você pode localizar rapidamente o arquivo no disco rígido. 

Com o botão  , você pode excluir o arquivo do database (o arquivo físico no disco rígido 
permanece) 
Ao clicar duas vezes no ícone  , você pode escolher arbitrariamente se a base possui Karaokê ou 
não. 
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QUICK ICONS 
 

 
Na parte direita da barra, você pode ver vários botões coloridos que permitem acesso rápido às 
várias funções e modos: 
(Lembre-se de que esses botões rápidos podem não ser exibidos se a resolução do monitor não for 
adequada como nos notebooks com monitores pequenos) 
• PRF: tecla rápida para retornar ao modo Performance 
• EXP: tecla rápida para entrar no modo Media Explorer 
• MDR: Tecla rápida para acessar o Metrodrummer (Virtual Drum Machine) 
• WDJ: Tecla rápida para acessar o Winlive DJ Control 
• CDP: tecla rápida para acessar o CD Player 
• BKT: tecla rápida para acessar as músicas de fundo 
• KMN: acesso ao monitor de karaokê 
• DBS: acesso ao database 
• EDT: acesso ao modo de edição 
• MDB: abertura da barra de melodia 
• PNO: Abertura do teclado do piano 
• CHD: abertura da barra de acordes 
• VL +: Volume (aumento) 
• VL-: Volume (diminuir) 
• PLY: Reproduzir 
• STP: Pare 
 
É possível editar os ícones rápidos ("Ícones rápidos") e atribuir cada uma dessas funções 
específicas 
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MARKERS 

 
Os markers permitem acesso rápido a várias seções dentro de uma música. Para registrá-los, é 
necessário entrar no modo de edição (consulte o capítulo dedicado). 
Quando um dos markers é definido como localizador inicial, o fundo do botão correspondente ao 
localizador fica verde; por outro lado, quando um dos markers é definido como localizador final, o 
fundo fica vermelho. 
Definir os markers de partida pode ser útil, por exemplo, para pular a parte introdutória e iniciar a 
música diretamente do verso. 
É possível acessar rapidamente os markers clicando com o mouse no botão correspondente ao 
localizador ou usando as teclas numéricas (de 1 a 0). Para arquivos médios, pressionar o 
localizador através do teclado numérico permitirá acessar o ponto reservado "in time". 
A criação dos markers pode ser realizada no modo Editar ou eles podem ser criados "on the fly" no 
modo performance, pressionando as teclas ALT + 1, ALT + 2 .... ALT + 10 correspondente aos 10 
markers para cada arquivo (midi, áudio ou vídeo) 
As bases de arquivos médios adquiridas da Songservice do M-Live contêm os markers já inseridos 
 
PRÉ-ESCUTA  
Para usar esta função corretamente, você precisa de uma segunda interface de áudio (consulte o 

capítulo Opções). Para acessar, clique no botão  após reservar uma música em áudio (MP3 ou 
WAV). 

 
 
Para uma configuração rápida, faça uma pausa na hora certa (normalmente BARRA DE ESPAÇOS) e 

pressione ENTER ou clique em . Quando chamada, a base começará a partir do ponto de 
sugestão escolhido. 
 
Para uso mais detalhado: 
Com a tecla Set (J) é possível definir o ponto inicial da música e com a tecla Test (H) é possível 
visualizar a música a partir do ponto definido. Com as chaves de transporte << ou >>, é possível 
editar o ponto de partida com precisão. Também é possível, através da barra Gain, definir o 
volume da música. Depois de concluir a pré-audição, você pode confirmar o ponto de sinalização 

com o CueOK (ou botão G) e sair salvando as alterações com o botão , ou sair e cancelar 

clicando em  
Quando a música que está sendo tocada termina, ou quando a mixagem (tecla Y), desbotamento 
(tecla Q) ou início imediato (envio) é executada, a música reservada começa do ponto definido 
durante a pré-audição. 
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MONITOR KARAOKE 

Você pode ativar o segundo monitor clicando no menu "Visualizar" -> "Monitor de Karaokê" ou 
CTRL + K no teclado. 
Uma segunda janela do Winlive será aberta, a qual você pode arrastar no segundo monitor; clicar 
duas vezes nele será definido como tela cheia. 
Ao clicar com o botão direito do mouse na tela principal do monitor, você pode alterar o caráter e 
o modo do Monitor de karaokê, podendo escolher entre: 
• Karaoke de rolagem multilinha; 
• Karaokê com animação de 4 linhas; 
• WinLive Classic: 2 linhas; 
• Estilo moderno: 4 linhas; 
• Modo de atril: 4 linhas + 1 
• Modo Zoom de karaokê 
• Sem karaokê 

 
Nota: para que esse recurso funcione corretamente, nas importações do Windows, selecione o 
segundo monitor no modo Área de trabalho estendida. Consulte o manual da placa de vídeo. 
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MELODY BAR 
É ativado e desativado através do menu "Visualizar" -> Barra de melodia ou pressionando o 
comando rápido do MDB ou usando a tecla da letra "E". Recomendamos enfaticamente como 
reiteraremos o uso das teclas do teclado do PC em vez do mouse várias vezes. 
Com um simples toque, a tela, como a abaixo, será exibida, descrevendo acordes (se presentes na 
faixa de acompanhamento) e notas da melodia. Obviamente, isso apenas para arquivos 
midi.

 
Uma segunda pressão permite visualizar (foto ainda abaixo) apenas os gráficos da tendência e o 
tempo da melodia (faixa 4 no caso do midi, com base no texto no caso do mp3), para ajudar o 
cantor a ir para tempo com a base. Esse recurso é muito apreciado, especialmente nas noites de 
karaokê. 
Você pode definir a barra de melodia fixa ou deslizante (consulte o capítulo Opções). 

Se fosse definido como fixo, a mudança de página ocorreria em correspondência com a linha 

vermelha (geralmente a cada 40 segundos). 
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CHORD BAR 
É ativado através do menu "Visualização" -> "Chord Bar" ou pressionando o comando rápido CHD 

ou através da tecla da letra "C". 

Veja os acordes (se houver), rolando-os simultaneamente com a música durante a execução. 

Lembre-se de que os acordes podem ser visualizados na notação anglo-saxônica (A, B, C, D, etc.) e 
na notação italiana (Do, Re, Mi, etc.) 
The related chords options can be found in ToolsOptionsChords and text 
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Além da barra de acordes, você pode ver os acordes diretamente no texto clicando com o botão 
direito do mouse na tela principal -> "Modo Karaokê" -> "Suporte de música com acordes". 

 
 

E, finalmente, você também pode ver os acordes de rolagem na barra de melodia selecionando 
"MOSTRAR SÓ CÓDIGOS" em Configurações 
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MIXER 
Para selecionar os canais midi ou gerenciar o áudio, é necessário abrir o mixer (tecla 'X') ou clicar 

em . 
A janela Mixer localizada no lado esquerdo da tela "Performance" permite manter sob controle 
vários parâmetros, tanto midi 
quanto áudio. 

 

 

 

Clique em um item para abrir um menu suspenso e faça 

uma escolha, incluindo ativar / desativar a faixa, solá-la ou 

ativar todas elas. Também é possível inserir os detalhes da 

faixa, aplicar um efeito MFX, selecionar Edição de 

percussão e Edição de som do usuário (veja detalhes). 

Em vermelho os canais silenciados em branco os ativos. 

Você pode ativar / desativar um metrônomo clicando no 

botão correspondente. 

A tecla Comp ativa e desativa a compactação da dinâmica 

dos arquivos midi. 

Através da coluna Dispositivo, é possível selecionar uma 

saída Midi diferente para cada canal individual. Você pode 

aplicar essas configurações do dispositivo a todas as 

músicas clicando no botão Bloquear. 

Através do estilo Remix, é possível alterar o estilo da base, 

escolhendo entre os vários estilos e podendo aplicar 2 

tipos de variação e o uso de percussão, a introdução e o 

final do estilo. Obviamente, isso é válido apenas para 

arquivos midi; 

Na seção Áudio, encontramos o Volume Fader para ajustar 

o nível de saída de áudio, os três faders para equalizar o 

som; Ganho ajusta o ganho da base de áudio; o fader V.Att 

regula a atenuação da voz. Os faders Master Track Effects 

(A - B) ajustam o volume dos efeitos selecionados no 

menu suspenso na caixa correspondente; 

Gerenciamento de canais panorâmico e direito e esquerdo 

para arquivos MPX 

Efeitos da 2ª faixa (C - D) ajustam o volume dos efeitos 

selecionados no menu suspenso na caixa correspondente 

da segunda faixa; 
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A seção Drum Part Off permite excluir os sons das partes da bateria, permitindo escolher 
individualmente cada parte da bateria a ser excluída. 
A seção MIDI apresenta um fader de volume para aumentar ou diminuir o mesmo, e os faders 
para medir o nível de reverberação e coro da base midi. 
A função "Winlive Midi Cover" permite que você escolha um dos registros predefinidos para variar 
a sensação e o estilo de um arquivo midi, que você deve tentar !! 
* A eficácia desta funcionalidade varia dependendo da base. 
 
Os detalhes (no mixer, clique no nome de um instrumento) 

 
 
Nesta janela, é possível controlar em detalhes as funções de uma faixa, escolher o instrumento de 
uma família de sons, a faixa, o volume, o pan, o coro, o atraso e a reverberação (no caso de 
expansor), a tecla (+/- 12 semitons), a atividade e coloque-a em "solo". 
A nova função "mecanismo de sintetizador MFX" permite a adição de um efeito entre distorções, 
compressores, ênfase de médias, altas e baixas, etc. 
A abreviação 'PC' identifica o número de mudança de programa transmitido. 
É possível editar os sons variando parâmetros diferentes (funciona apenas no caso do expansor): 
- Timbre: aumenta ou diminui a ressonância; 
- CutOff: aumenta ou diminui o corte de frequência; 
-Attack/Release/Decay: regula o envelope do som, de acordo com o seguinte esquema:  
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 A tela, no caso de seleção do canal 10 / bateria, muda da seguinte forma: 

 
 
Isso exibirá os DrumKits padrão em vez das famílias de sons. 
É possível, se um gerador externo de tons for usado, escolher também o DrumKit não padrão 
exibindo a alteração de programa relativa. 
4 bancos podem ser criados com 8 sons cada; para cada som é possível editar o nome, a Mudança 
de Programa a ser enviada [0 ... 127], o valor da Mudança de Controle [0 ... 127] (é possível enviar 
o CC # 0 e / ou o CC # 32, consulte o manual expansor) e, finalmente, todos os vários parâmetros 
que caracterizam o som. 
Para uma visualização, você pode clicar na caixa na parte inferior esquerda ou pressionar a tecla 
Ctrl esquerda. 

Após a criação do banco, ele deve ser salvo clicando no botão .  
Também é possível exportar bancos de som para arquivos externos e importá-los novamente mais 
tarde. 
Essa função é muito útil se você usar mais de um expansor externo, pois poderá criar vários 
arquivos de som personalizados, um para cada expansor. 
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Também é possível alterar o som único de um tambor usando a função Drum Editing com 
variações dinâmicas (% Dyn) para cada som. 
  

 
 
Nesta tela, você pode substituir os sons de bateria individuais no Canal 10. 
O número máximo de sons editáveis é 8 e, para cada som, você também pode editar a intensidade 
da dinâmica e ouvi-los na visualização clicando em 
A janela na parte inferior mostra os nomes de todos os instrumentos de bateria usados pela 
música atual, destacando os modificados em amarelo. Ao clicar em redefinir, você pode restaurar 
a bateria original. 
O salvamento virtual permite armazenar a alteração no database. 
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Ao clicar em "User drum kit", a tela muda da seguinte forma: 

 
 
Onde você pode configurar seu próprio kit de bateria personalizado.
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Ao clicar em "Editor de banco de som", é possível criar novos bancos de som. 
 

 
 
 
Na seção do mixer também encontramos o gerenciamento de arquivos MPX. Nesse modo, você 
pode gerenciar e salvar o canal esquerdo ou direito do arquivo de áudio. 
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TECLADO VIRTUAL 

Essa função que começa pressionando o botão  no canto superior direito do vídeo em 
Performance permite ativar um teclado virtual, conforme mostrado na foto abaixo: 

 
 
Ele permite que você use os comandos básicos se usarmos WINLIVE no TABLET. 
ou tela de toque. 
As teclas F1 / F9, Shift F1 / F10, Ctrl F1 / F10, Shift + Ctrl F1 / F10 são usadas para selecionar as 
listas de músicas; 
Esc fecha a lista; 
as setas esquerda e direita rolam a lista na direção comandada; 
  as teclas + F10 e - F10 removem ou adicionam músicas na lista provisória F10; 
Iniciar, permite iniciar a música selecionada; 
Mix, permite mixar entre uma música e a próxima; 
o botão X fecha a função. 
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GRAVAÇÃO DE FAIXA DE ÁUDIO 
Com esta função, é possível gravar uma faixa de áudio em uma base presente no DataBase usando 
o botão apropriado. 

 
 
No painel, você pode selecionar a entrada do dispositivo de áudio e do dispositivo de linha 
O volume possui um fader de ajuste do sinal de entrada. 
O nome do arquivo indica o caminho para salvar a faixa gravada, mas é possível alterá-la digitando 
a tecla apropriada. 
Formato WAV indica o formato padrão para salvar a faixa, mas isso também pode ser alterado 
digitando o botão apropriado. 
Ao clicar em "Iniciar teste", você pode executar um teste de gravação verificando o nível de 
volume recebido. No final do teste, digitar "Stop test" retorna à condição inicial. 
Os botões "Iniciar gravação" e "Parar" são usados para iniciar e finalizar a gravação, 
respectivamente. 
 
Nota: no momento esta função não está ativada no Mac OSx 
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AUDIO SAMPLER 

Usando o botão  você pode acessar o Sampler de áudio ou sampler. 

 
 
Com o sampler é possível reproduzir em tempo real, mesmo durante a execução de uma música, 
efeitos sonoros, imagens, pdf, textos ou loops. 
É possível ter 10 bancos de 10 amostras cada, para um total de 100 amostras. 
Para carregar as amostras, clique na caixa ao lado de cada amostra (quando nenhuma amostra é 
carregada, “No file Loaded” aparece) e escolha o arquivo na caixa de diálogo. 
Para cada amostra, você pode ajustar o volume. Você pode reproduzir as amostras no Polyphony 
ou, marcando a opção Mono, reproduzi-las no Monophony (ou seja, se uma amostra estiver em 
execução e outra for chamada, a amostra em execução será encerrada). 
A opção Comp permite, se marcada, ativar um compressor geral nas amostras, que uniformiza 
automaticamente seu volume. 
Durante a apresentação, é possível acessar rapidamente o sampler com a tecla 'S', pressionando 
as teclas de 1 a 0 no teclado. Para interromper a reprodução das amostras de maneira forçada, 
pressione o botão '\’ 
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SONGLIST EDITOR 
Você pode acessar o SongList Editor através do menu "Ferramentas" ou clicando no canto inferior 
esquerdo ao lado do nome da lista de músicas. 

 
 
Através dessa funcionalidade, é possível renomear cada escada única: 
1 - marcando a caixa STOP, queremos que a execução da lista pare no final de cada música, 
enquanto que se não inserirmos a verificação, a execução das músicas da lista será contínua; 
2 - marcando a caixa MELODY, cada música da lista será tocada sem o guia melódico (midifile); 
3 - a função ORDER fornece um menu suspenso no qual você pode escolher a ordem de execução 
das músicas (se indicarmos TITLE, por exemplo, teremos uma ordem alfabética, e não por ID, por 
intérprete, por autor e assim por diante). 
ORDEM PADRÃO: aqui podemos selecionar uma ordem geral, desde que não haja uma ordem 
específica no SongList.
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MIXING EDITOR 
O Editor de mixagem pode ser acessado através do menu "Tools". 

 

Com o editor de mixagem, você pode definir o progresso e a duração (em milissegundos) do Cross-
Fade, ou seja, a mixagem de duas faixas de áudio. 

A linha verde indica a música a ser concluída, enquanto a linha vermelha indica a música 
reservada. 

Por padrão, o WinLive adotará um comportamento do tipo Linear, com uma redução progressiva e 
constante do volume da base a ser finalizada, simultaneamente com um aumento progressivo e 
constante do volume da reserva. Você pode selecionar 5 curvas predefinidas ou desenhar uma 
curva personalizada.
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LISTA DE CANÇÕES EXECUTADAS 
Cada música tocada no modo Performance e em tempo real é armazenada pelo Winlive. Você 
pode salvar esta lista em um arquivo de texto. 
O título da peça executada e seu autor são indicados. Na ausência do autor, o intérprete é 
indicado (marcado com um asterisco) 
Selecione o menu "Tools" -> "Lista SIAE", a seguinte janela será exibida: 

 
 
Todas as listas SIAE são armazenadas na pasta \ SIAE *, visível através de Tools / Lista SIAE. 
O botão "Redefinir" permite excluir todo o conteúdo da lista. 
“Fechar fecha a função. 
Com a tecla de pesquisa "monitor", é possível procurar a localização dos arquivos SIAE LIST. 
O menu suspenso permite selecionar quando salvar a lista: 1 - cada vez que o programa é fechado; 
2 - no final de cada música. 
 
* No Windows 7 e em algumas versões do Windows Vista, a pasta \ SIAE é armazenada no 
caminho virtual, geralmente  
C:\Users\ SEU NOME DO USUÁRIO\AppData\Local\VirtualStore\Arquivos de Programas\WinLivePRO\ SIAE 

No entanto, o caminho virtual é acessível através do modo Media Explorer (consulte o capítulo 
dedicado).
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ECONOMIA FÍSICA DA MÚSICA 
É acessado através do menu "Tools" -> "Save song". 

 

Com essa funcionalidade, é possível salvar virtualmente ou fisicamente as alterações feitas nos 
arquivos Midi. 
Ao marcar a opção "Salvar da primeira nota", você tem a opção de interromper os segundos de 
silêncio que possam estar presentes no início de uma música. 
A coluna "Saída" permite alterar os canais para cada faixa individual. 

Exemplo: em algumas bases, a faixa da melodia vocal não é salva no canal 4 (conforme previsto 
nas normas), mas em outros canais, por exemplo no canal 1. Para inverter as faixas, basta escrever 
"4" em correspondência com o canal 1 e "1" no canal 4. 

A coluna "Faixa" permite salvar ou não a faixa 
A coluna "Instrumento" indica um instrumento alterado e o salva. 
A coluna "Vol" indica se uma alteração de volume foi feita (100 = 100% do volume original). 
A coluna "Dyn" indica se uma alteração dinâmica foi feita 
A coluna "Vol. Fixo" define um valor salvo para o volume midi 
Você também pode optar por incluir o texto ou os acordes do karaokê no arquivo. 
A caixa "Adicionar segundos ao final" permite adicionar um número de segundos ao final de uma 
música. 
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Você pode escolher a faixa a ser editada e a possibilidade de incluir o texto e os acordes. 

Com a chave  as alterações são salvas virtualmente no database, enquanto as chaves  

    eles são usados para salvar fisicamente os arquivos médios 

E para salvar todas as músicas presentes no F10 no formato midi. 

Com os botões  você pode converter respectivamente um arquivo do 
Midi para o Wave e transformar todas as músicas do F10 no formato Wave. 

A tecla  permite transformar um arquivo MIDI no formato MP3, com a 
possibilidade de escolher a qualidade do som do arquivo pressionando a tecla de seta. 
 
Nota: no caso de arquivos Mp3, agora é possível salvá-los virtualmente e fisicamente. 
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SINCRONIZAÇÃO DE TEXTOS / ACORDOS 
É acessado através do menu "Tools" -> "Sincronização de letras / acordes". 

 

Com esse recurso, você pode adicionar um texto de Karaokê aos arquivos Midi e Audio. 

O texto é carregado colando-o na janela ou abrindo um arquivo TXT com a tecla . 

Usando a tecla  é possível salvar o texto em um arquivo TXT, enquanto com a tecla  é 
possível converter todo o texto em maiúsculas. 
Com o botão "Importar de Midi / Áudio", é possível importar um texto de um arquivo midi ou de 
áudio já gravado, mas apenas se você estiver editando uma faixa de áudio. 
A sincronização pode ser feita por linha, por palavra e por sílaba. 
Para sincronizar, pressione o botão "Iniciar sincronização". Nesse ponto, a base será iniciada e, 
pressionando a tecla Enter, repetidamente e dentro do prazo da sincronização. 
Comece como inserir acordes, marcando a caixa "Modo de acordes". 
Para qualquer modificação do texto sincronizado ou dos contratos, consulte a seção "Modo de 
edição" do menu Exibir.
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WINLIVE CD PLAYER 

É acessado através do menu "Tools" -> "Iniciar o WinLive CD Player / Extract" ou através do botão 
CDP no modo Performance. 

 
 
Com esta função, é possível extrair faixas dos CDs de áudio e salvá-las no formato Wav ou Mp3. 
É necessário selecioná-los (você pode selecioná-los todos através do botão "Todos" ou 
manualmente, clicando na primeira coluna) e, em seguida, clique no botão Converter. 
Você pode escolher entre Wav descompactado (Wave não compactado) e Mp3, variando a 
qualidade de acordo com as suas necessidades (por exemplo, "Mínimo apenas para 
armazenamento de voz") gera um arquivo de baixa qualidade com a menor pegada no disco, 
enquanto "Máximo" qualidade ”gera um arquivo de alta qualidade, mas também com o maior 
tamanho de disco). 
 
A peculiaridade deste CD player é que ele possui os recursos avançados dos CD players comerciais 
de DJ, ou seja, permite alterar o tempo e a entonação (tecla) em tempo real.
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EDIT MODE 
 
Markers de música 

 

O uso dos markers permite o salto em tempo real para diferentes pontos da música. Por exemplo, 
você pode associar o proprietário 1 à introdução, o proprietário 2 ao primeiro verso, o proprietário 
3 ao refrão, etc. 

O número máximo de proprietários é 10 por música. 
Existem várias maneiras de registrar novos locadores depois de enviar a música para tocar: 
• pressione ALT + [número de 1 a 0]; 

  ou clique no localizador que deseja registrar (ou substituir) na tabela e, em seguida, clique 

no botão  
• ou clique com o botão direito na barra na parte inferior 
• ou com a tecla 'L' (adiciona-os em ordem). 

Para reposicionar os markers: 

• Use as teclas ALT e + ou ALT e - 

• Clique com o botão esquerdo na barra na parte inferior e mova-a com o mouse. 

• Use as teclas para uma posição cada vez mais precisa do localizador 

 

Para remover um localizador, selecione-o na mesa ou na barra na parte inferior e pressione 
DELETE. 
Você pode renomear os proprietários, clicando duas vezes na tabela. 

Usando o botão  você pode adicionar imagens associadas aos vários markers (por exemplo, 
você pode adicionar a imagem de uma pontuação) para poder mostrar uma ou mais imagens por 
base em andamento. 
 
Você pode usar markers para definir um ponto inicial e final de música. 
For example, Marker 2 can be set to the first verse, skipping the Introduction, and Marker 9 at the 
end of the penultimate verse, so as to end the song before the "tail". 
Once the Markers have been set, and any starting and ending points, it is necessary to save by 
clicking on the Save button. 
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Os Markers podem ser salvos apenas se o arquivo (Áudio ou Midi) tiver sido importado 
anteriormente no database. 
 
Por exemplo, você pode definir o localizador 2 no primeiro verso, pulando a Introdução e o 

localizador 9 no final do penúltimo verso, para encerrar a música antes da "cauda". 

Depois de definir os markers e quaisquer pontos de partida e de chegada, é necessário salvar 

clicando no botão Salvar. 

Os markers podem ser salvos apenas se o arquivo (Áudio ou Midi) tiver sido importado 

anteriormente no database. 

Enquanto a música está tocando, os markers podem ser chamados rapidamente pressionando o 

número no teclado correspondente, enquanto para os midifiles a próxima batida da música será 

esperada. 

Com a combinação Shift + [tecla numérica], a mudança para o localizador chamado ocorrerá 

imediatamente. 

Se os markers forem salvos, eles estarão visíveis na próxima barra de música, pressionando 
Control + [tecla numérica] ou clicando no localizador de músicas reservado, em Performance, 
permitindo que a próxima música comece a partir de um localizador escolhido arbitrariamente. 
 
Midi Mixer 
Imediatamente após a parte dedicada aos proprietários, é visível uma versão simplificada do 
Mixer, claramente válida apenas para arquivos Midi. 

 
 
Para cada canal individual, é possível ajustar o volume, silenciar ou alterar os instrumentos 
(clicando no nome do instrumento do canal correspondente).
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EDITOR KARAOKE  

É acessado através do botão .  

 
Com esta função, é possível editar o texto do karaokê de maneira avançada. 
Ao clicar em cada palavra, é possível editá-lo alterando o texto ou movê-lo graficamente 
antecipando ou adiando. 
O Shift-Slide permite traduzir o texto inteiro, antecipando-o ou adiando-o em um determinado 
número de milissegundos, indicado na correspondência. 
Collapse-Expand comprime ou expande a distribuição do texto 

A tecla  coloca todo o texto em MAIÚSCULAS. 

O botão  otimiza automaticamente o texto movendo as alterações de página, a fim de 
simplificar a leitura do karaokê durante a reprodução, além de remover as linhas vazias duplas, 
removendo as alterações de página dupla. 

O botão  permite a inserção de novo texto. 
Todas as alterações feitas são salvas com a tecla "SAVE". 
 
Editor de acordes 
De maneira semelhante ao Editor de Karaokê, você pode acessar o Editor de acordes para editar 

os acordes, usando o botão  
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DATABASE 
Abaixo está o diagrama da tela "Database" do Winlive Pro / Pro Synth 10 

 
 
- Crie, abra e salve 
Em Perfomance, é possível acessar o database clicando no menu no topo Database -> Database 
ou em Visualização -> Database ou clicando no botão rápido (ícones rápidos) DBS 
Pode ser acessado sem o uso do mouse pressionando as teclas CTRL + ALT + D 
 
O Winlive Pro 10 permite gerenciar vários bancos de dados. 

• Para criar um novo database, pressione o botão:   
O Winlive perguntará se deseja salvar o database já presente, após o qual esvaziará o database 
atual. 

 Para abrir um database existente, pressione o botão:  
O Winlive solicitará que você especifique o nome do database a ser aberto. 

 Para salvar o database atual com um nome, pressione:   
O Winlive solicitará que você especifique o nome do database a ser salvo. 

 Para importar um database criado com as versões 5.5 / 4.5 / 4.6 / 4.7 / 5.0 / 5.5, pressione: 

 
O Winlive solicitará que você especifique o nome do database a ser importado. 

 Para fazer um backup do database, pressione:  

 Para restaurar o backup criado anteriormente, pressione o botão:  
O Winlive mostrará a data e a hora do backup. 
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Aviso: : criar um novo database ou restaurar um backup excluirá o da memória se você não o 
salvar. 
 
- Mude as células  
Você pode alterar os valores nas células clicando duas vezes em uma célula se estiver no modo 
"Seleção" ou pressionando a tecla "E" 
Clique único se você estiver no modo "Editar". 
Em alguns campos a entrada será guiada, em outros é possível escrever diretamente dentro, 
outros campos são informativos e não será possível editá-los, por exemplo Tipo de campo, ID ... 
 
É possível editar alguns valores rapidamente através da janela "Visualizar", na qual também é 
possível ouvir uma visualização com as configurações aplicadas. 

Clicar com o botão direito do mouse em uma célula (ou em uma seleção de células) 
permite acessar um menu através do qual você pode executar várias operações: 
- Selecionar tudo: destacar todas as músicas 
- Redefinir seleção: cancela a seleção das faixas 
- Copiar: copiar 
- Editar: edita a célula selecionada 
- Inserção de vários campos: permite inserir um nome em várias faixas simultaneamente. 
Por exemplo, quero inserir o artista ELTON JOHN em todas as músicas selecionadas 
- Classificar A-Z: classifica em ordem crescente na coluna selecionada 
- Classificar Z-A: classifica decrescente na coluna selecionada 
- Excluir database: exclua a música do database, mas não fisicamente do disco rígido 
- Classificação agrupada por SongList: classificando em ordem crescente de acordo com o 
SongList 
- Usar nome do arquivo como título: o nome do arquivo é exibido na coluna TITLE 
- Obter intérprete / autor do nome da pasta: o nome da pasta é exibido nas colunas Artista 
ou Autor. 
- Mover para lista: move as músicas selecionadas de uma lista de músicas para outra 
- Copiar para lista: copia as músicas selecionadas para uma lista de músicas 
- Substituir parte da rota: substitui uma rota completa ou parte dela por uma rota 
diferente. Por exemplo, se eu movi fisicamente algumas músicas da pasta C: \ SONGS em 
D: \ MY SONGS, tenho que selecionar as músicas interessadas e escrever como na figura 

 
-  Silenciar canais: para selecionar os canais a serem silenciados 
-  Copy IN: copia fisicamente as músicas de uma pasta para outra, com a possibilidade de 

atualizar os caminhos no database 
-  Move IN: move fisicamente as músicas de uma pasta para outra, com a possibilidade de 

atualizar os caminhos no database  
- Localizar e mostrar arquivos duplicados: esta função também é acessível a partir do ícone 

.  
Na prática, mostra duplicatas nos vários modos  
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Principalmente, o arquivo duplicado pode ser entendido como uma música proveniente do 
mesmo caminho ou música com o mesmo título 

- Depois que o campo do database a ser estabelecido como parâmetro para o arquivo 
duplicado for decidido, a prioridade deverá ser escolhida (ID como ordem de carregamento 
ou lista de músicas 
pertencente)

 
 
Depois que o botão CHECK é pressionado, as faixas duplicadas são destacadas 
e a operação a ser realizada: 

 
Lembre-se de que essa operação é irreversível; portanto, recomendamos que você salve o 
database primeiro 
- Análise de arquivos - Informações sobre tags MP3: esta função extrapola as informações 
dentro dos arquivos mp3, como título, artista etc. 
- Converter título para: conjunto de funções de texto, como maiúsculas, minúsculas, 
eliminar espaços desnecessários, etc. 
- Dividir campo do título: permite dividir o título e o autor se as duas informações 
estiverem presentes na coluna TITLE 
- Duplicar: é usado para duplicar os arquivos selecionados 
- Localizar arquivos no disco: abre diretamente a pasta de origem dos arquivos no disco 
rígido 
- Remover arquivo do disco: permite excluir fisicamente o arquivo do disco e 
simultaneamente do database. Atenção, esta função é irreversível 
- Crie e salve o arquivo YTB (música do YouTube): depois que uma música do YouTube é 
selecionada, ela é salva em um arquivo físico externo. Lembre-se de que o arquivo do 
YouTube é um link simples para um vídeo do YouTube 

- Multi- seleção 
Se você mantiver a tecla CTRL pressionada, poderá selecionar várias músicas para operar em 
grupos. 
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Se você estiver no modo "Seleção", a música será desmarcada clicando nela, enquanto no modo 
"Editar" basta clicar em qualquer campo para desmarcar tudo. 
 
- Colunas do database 
Agora vamos ver em sequência as colunas do database 
ID: indica o número em progressão cronológica das músicas importadas 
Lista de músicas: o SongList pertencente é exibido 
Título: indica o título da música 
Artista: executante da peça (artista) 
Autor: autor da peça. Esta informação é útil quando queremos preencher a fronteira do SIAE 
Genre_Notes: podemos inserir o gênero da música ou anotações na própria música 
Tipo: valor não editável. Indica o tipo de arquivo (médio, mp3, vídeo etc.) 
Karaokê: valor não editável. Indica a presença do texto dentro do arquivo. É válido apenas para 
arquivos midi e mp3s 
Tempo: valor não editável. É o tempo relativo à música 
TempoP: é o tempo editado 
ChOff: indica canais mudos para midifiles 
Transpor: exibe o tom alterado 
Volume: o volume padrão da música (100 significa volume como no original) 
Mídia: arquivo associado à base (por exemplo, associando um pdf, uma imagem, um som etc.) 
Arquivo de texto: texto associado à música (txt ou rtf) 
Ordem: permite criar uma ordem personalizada das músicas na lista sonora 
Quando queremos criar um pedido personalizado, precisamos inserir uma série de números para 
criar um critério numérico 
Por exemplo, se queremos criar uma lista de reprodução com esta sequência personalizada 
IMAGINE - YESTERDAY - MICHELLE – LET IT BE 
Vamos inserir esses números, por exemplo: IMAGINE (15) – YESTERDAY (21) - MICHELLE (50) – LET 
IT BE (88). Independentemente dos números inseridos, o importante é criar uma sequência 
numérica crescente 
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Depois de fazer isso, lembre-se de atribuir essa ordem de classificação a este SongList no 
SONGLIST EDITOR 
Tecla: indica a tecla da música 
-Importação das músicas 
Vamos tentar inserir algumas músicas: 
Vamos para o lado esquerdo do database chamado Explorer. 
Selecione uma pasta e abra-a com um clique duplo 
As músicas contidas na pasta em questão serão exibidas. 
Se a pasta estiver localizada na área de trabalho ou em documentos, podemos visualizá-las 

simplesmente clicando no botões :  
Podemos selecionar uma música, várias músicas (mantendo pressionada a tecla CTRL) ou todas as 
músicas 

pasta pressionando o botão:  

Ao clicar em   , os arquivos selecionados são importados 
 

 
 
Agora você pode selecionar: 
• O SongList de destino; 
• Copiar para: uma pasta secundária na qual salvar fisicamente as cópias dos arquivos importados; 
• ..e excluir (MOVE): os arquivos selecionados são movidos fisicamente para outra pasta 
• Os canais silenciosos para arquivos Midi; 
• Usar nome do arquivo como título: exibe o nome do arquivo como o título da música (coluna 
Título) em vez do título normalmente encontrado no próprio arquivo; 
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• Importação rápida: acelera a importação ignorando algumas informações; 
• Não importe se ele já existir no database: evite carregar arquivos no database; 
• Escreva Intérprete como nome da pasta: escreva o artista da peça (coluna Artista), pegando as 
informações da última pasta da qual a peça vem 
Nota: a importação rápida executa o processo com extrema rapidez, mas não permite verificações 
completas da integridade do arquivo e das tags MP3. 
 
De qualquer forma, os arquivos que serão considerados inválidos, como o Midi, com notas 
atoladas ou sem informações vitais, não serão importados para não comprometer o Perfomance 
do usuário. 
De qualquer forma, no final da importação, um breve relatório será exibido sobre os arquivos 
importados e inválidos. 
 
Atenção: as verificações de integridade não serão executadas nos arquivos das Listas de Pastas da 
Música e nos arquivos lançados dinamicamente com Carregar Arquivo 
 
Ícones de database 

 
Respectivamente: desmarque tudo, selecione tudo, selecione vários 
 

 
 
 
 
 

 
Defina filtros na exibição com base no tipo de arquivo e / ou na lista de 

músicas à qual ele pertence 
 

 

 

 

Na ordem: 
-Retornar ao modo Performance 
-Abra um database (novo) 
-Salve um database 
-Novo database 
-Importar database de uma versão anterior 
-Encontre e mostre arquivos duplicados 
-Faça um backup do database 
-Restauração do backup anterior 
-Configuração do database para alterar os parâmetros de exibição 
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Linha superior: 
 
- Mover as músicas para outra lista de músicas 
- Abrir janela Importar música 
- Excluir música ou seleção de músicas do database 
- Exclua todas as músicas agora mostradas na grade, mesmo que não 
estejam selecionadas 
- Use o nome do arquivo como título para a música selecionada 
-Procure um título entre as faixas na grade 
- Monitor de karaokê aberto 
- Importe a lista de músicas de Vanbasco 
 

  

  

 
 
Linha inferior: 
 

 

-Copie o arquivo para outro destino físico 
-Procure por arquivos “ausentes” (arquivos ausentes ou com caminho 
incorreto) 
-Abra o Gerenciador SongList (editor SongList) 
-Substitui o caminho ou nome do arquivo 
-Crie um relatório de database no formato HTML 
-Crie um relatório de database no formato Excel 
- Localize o arquivo no disco rígido 
- Otimização de títulos 
 

 

  

- ARQUIVOS AUSENTES  

Para procurar órgãos, clique no botão:  
Dica: posicionar um ícone em uma pequena etiqueta fornecerá uma breve descrição 
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Arquivos Ausentes 

 

O recurso Pesquisa de arquivo ausentes permite verificar todo o database procurando arquivos 
que não são mais encontrados no disco rígido, pois eles podem ter sido excluídos ou movidos para 
outra pasta. 

Para encontrar órfãos, pressione o botão "Verificar". Após a conclusão da verificação, você pode 
excluir correspondências do database (Remover tudo) ou mostrá-las no database. 

A função Pesquisar procura todos os arquivos “Arquivos ausentes” e, uma vez identificados, o 
caminho relativo no database é atualizado automaticamente. 

Com Nova Rota, por outro lado, a nova rota é atualizada manualmente 
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MEDIA EXPLORER 

Sugerimos que nossos usuários com dezenas de milhares de bases usem os dois modos: Database 
e Media Explorer 

No Database, seria melhor inserir as músicas do seu repertório que precisam de gerenciamento e 
salvamento personalizado de diferentes parâmetros, enquanto no Media Explorer a simples 
execução de músicas, talvez com variação de transposição e anotações para cada música. O último 
modo é especialmente adequado para quem executa apresentações de karaokê 

Portanto, no Media Explorer, você pode executar as músicas diretamente do disco rígido, com 
uma pesquisa muito rápida e inteligente, também pode aplicar filtros de exibição e possivelmente 
importá-los para o database Winlive 

 

Ao clicar em Predefinições >>>, você pode abrir caminhos predefinidos ou selecionar uma pasta 
inicial na qual e nas subpastas relevantes o Winlive pesquisará 
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PESQUISA 

Depois de inserir o título da música ou parte dela a ser pesquisada, o WINLIVE pesquisará 
rapidamente todas as músicas que atendem ao critério de pesquisa 

Depois que a pesquisa for realizada, você pode selecionar a música e reproduzi-la rapidamente, 
pressionando Enter, ou pode agendá-la pressionando a barra de espaço ou clicando no 

botão . Com o botão , você pode reproduzir a música reservada (ou 
pressionando as teclas CTRL + Enter). 
NB: Para alternar para a música reservada misturando, pressione as teclas CTRL + Y, enquanto que 
para esmaecer as teclas CTRL + Q 
Se você deseja reservar mais músicas, acesse a música (possivelmente altere a tecla e as 

anotações), clique em ou no botão INS e assim por diante. 

As faixas reservadas serão exibidas pressionando a tecla F10 ou clicando no botão  
 
As músicas reservadas serão exibidas e infinitas PLAYLISTS podem ser criadas, salvas e recuperadas 
mais tarde 
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YOUTUBE VIDEO SONGS 
Aviso: aceite as condições do YOUTUBE antes de usar este serviço 
Lembramos que o serviço YOUTUBE é concedido até a próxima versão do WINLIVE ser lançada. 
Em poucas palavras, ele será renovado apenas se você atualizar para a próxima versão. 

Esta função pode ser acessada através do botão YouTube localizado no outro lado esquerdo, no 
modo Performance ou através de View -> YouTube songs ou YouTube Songlist 

Ou pressione as teclas (CTRL + ALT + Y) 

 

Como você pode ver na imagem, esta função permite pesquisar e exibir na tela as songs presentes 
diretamente no YouTube através da pesquisa do título e do artista. 

Obviamente, esta função requer conexão com a internet. 

Dentro da função, um filtro de pesquisa já está definido para as faixas de apoio do karaokê. Além 
da exibição, também é possível importá-las para uma SongList do database e inserir o título, 
artista, autor, chave. 

Atenção: Não é possível modificar a base e fazer o download da própria base. Só é possível 
importar o link para o database e recuperá-lo como se fosse qualquer parte do nosso database. 
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Além da função de pesquisa, é possível visualizar uma lista de músicas dos links do Youtube, basta 
clicar na Lista de músicas do YouTube (ou CTRL + ALT + L) 

Após o lançamento do arquivo do YouTube, é possível remover uma parte inicial (por exemplo, 
para pular uma introdução indesejada) clicando com o botão direito do mouse na apresentação e 
selecionando Inserir ponto de início do YouTube, inserindo os segundos para iniciar a música do 
ponto desejado 
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METRODRUMMER  

Com o MetroDrummer, você pode usar uma bateria eletrônica real com padrões rítmicos, 
acessível em Exibir -> MetroDrummer ou através do botão MDR localizado no lado direito do 
modo Performance  (CTRL+ALT+B) 

 

O Metrodrummer pode ser usado independentemente, reproduzindo os vários ritmos (mais de 
220) com padrões clássicos de bateria, como Introdução, Padrão, Variação e assim por diante. 

Muito útil, por exemplo, quando você deseja executar peças acústicas com a necessidade de uma 
estrutura rítmica básica (teclas: \ 1 2 3 4 5 6 e 7 para os vários padrões de bateria) 

O MetroDrummer também pode ser usado como metrônomo eletrônico para nossos exercícios 
clássicos de ensino pressionando o botão METRONOME 

Além disso, com o MetroDrummer, é possível sincronizar nossos midifiles com os vários ritmos, 
por exemplo, para executar um MEDLEY ao vivo, tocando os vários midifiles que executaremos no 
mesmo ritmo. 

Clique em MIDIFILE SYNCRO (chave: 9) e no primeiro midifile e, em seguida, todos os midifiles que 
executaremos começarão com o ritmo predefinido, enquanto que com STYLE SYNCRO (chave: 0) é 
o midifile que sincroniza o ritmo do MetroDrummer 
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WINLIVE DJ CONTROL  

Seção simplificada para DJs, acessível através do controle View -> Winlive DJ ou através do botão 
WDJ no modo Performance (keys: CTRL+ALT+J) 

 

O modo Winlive DJ com reconhecimento de BPM para arquivos de áudio com efeitos em tempo 
real permite executar mixagens manuais e automáticas. 

Para executar o mix automático com a primeira faixa em reprodução e a segunda reservada, basta 
clicar primeiro no Tempo Sync e, em seguida, no mix automático, desta maneira o DJ do winlive 
mudará automaticamente de uma faixa para outra. 

Enquanto para mixar manualmente sempre com a primeira faixa em reprodução e a segunda 
reservada, basta clicar em Tempo sync primeiro e depois em Mix manual, neste caso, na parte 
superior, você encontrará as palavras em vermelho Mix 2%, basta clicar várias vezes no mix 
manual para avançar a porcentagem de mixagem e mudar gradualmente de uma faixa para outra. 

Além das várias mixagens, o Winlive DJ também permite inserir efeitos como Reverse Play, auto 
WHA e Phaser que podem ser usados através do teclado à direita.
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BACKGROUND SONGS (MÚSICAS DE FUNDO) 

Esta função permitirá que você crie uma lista de arquivos de áudio que podem ser usados como 
uma lista de reprodução em segundo plano quando o Winlive é colocado em Stop. 

É acessado a partir da TOOLS BACKGROUND SONG ou clicando com o botão direito do mouse 
no botão SOTTOFONDO em Performance 

 

Através do botão Adicionar música, permite adicionar arquivos de áudio à lista de reprodução. 
Carregar lista de reprodução permite carregar uma lista de reprodução salva anteriormente; 

Salvar lista de reprodução permite salvar a lista carregada naquele momento; 

Exclua todas as músicas mostradas agora para excluir todas as músicas do plano de fundo; 

A / a diminui a fonte enquanto a / A aumenta a fonte 

  e finalmente Random permite a reprodução aleatória das faixas em segundo plano. 

Esta função também permite ajustar o volume de execução, a Fade in para uma entrada gradual 
do substrato e a Fade out para uma saída gradual. 

Com o corte inicial do silêncio, é possível eliminar os silêncios no início da música e, finalmente, é 
possível estabelecer uma espera (em segundos) antes de iniciar o fundo 
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SUBTITLE KARAOKE MONITOR (MONITOR KARAOKE LEGENDADO) 

 

selecionado pelo View ModeSubtitles / karaoke monitor  
 
Essa configuração permite inserir uma legenda deslizante na parte inferior do monitor de karaokê, 
permitindo que você defina a cor, fonte, fundo, tamanho e velocidade de passagem da legenda. 
 
Útil quando você deseja lançar mensagens destinadas ao público em combinação com karaokê 
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NOTEPAD WINDOWS 
Permite visualizar um pequeno bloco de notas em vários formatos, onde você pode escrever notas 
durante nossas apresentações.  
Ao clicar no CLS, podemos excluir todo o conteúdo do bloco de notas 

 
É selecionado pelo View ModeNotepad Windows (CTRL+N) 
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ATALHOS 
Aqui está uma lista de teclas (atalhos) e funções relacionadas: 
 
(Windows) 
 
Barra de espaço   Abre a lista de músicas ou Pausa / reprodução da música 
Teclas de seta   Abre a lista de músicas relevante 
F1, F2, ..., F10    Abre a lista de músicas relevante 
Shift + [F1 .. F10]   Abre a lista de músicas relativa 
Ctrl + [F1 .. F10]   Abre a lista de músicas relativa 
Shift + Ctrl + [1 .. 0]   Abre a lista de músicas relativa 
1..2..3 ........ 0   Reproduza do Locador relevante ou do canal silencioso 
Shift + [1..0]    Reserve o Locador relativo 
Ctrl + [1..0]    Reserva o localizador relativo da música reservada 
Shift + Ctrl + [F1 .. F10]  Salta para o localizador relativo da música reservada 
O     Toque desde o início da música 
Q     Desvanece-se para a música reservada 
W     Altere o tamanho do texto do karaokê (pequeno grupo médio) 
Shift + W    Alterar o modo de texto no monitor principal 
Ctrl + W    Alterar o modo de texto no monitor de karaokê 
F     Próximo 
R     Voltar 
M     Melody Melodia (cap. 4) Sim / Não [Song Midi] 
T     Restaura o Tempo original [Song Midi] 
U     Solo Melody (Cap. 4) [Song Midi] 
N     Canais ativados / desativados como originalmente 
P     Falar sobre (na tecla pressionada) 
A     Ative todos os canais [Song Midi] 
K, L     Rolar para o texto no púlpito 
D     Apenas bateria (cap. 10) [Song Midi] 
C     Mostrar / ocultar acordes 
Shift + C    exibe / oculta os acordes no monitor de karaokê 
Y     Misture com a música reservada 
Shift + Y    Mixagem manual (depois pressione Y) da música reservada 
H     Percorre os modos de mixagem 
X     Abre o mixer 
I                   Abre o Mixer no modo Instrumentos (você pode pressionar as teclas 

1..0 e Q ... Y para as faixas On / Off) 
V     Faixa vocalista (cap. 16) Sim / Não [Song Midi] 
B     Apenas baixo (cap. 2) e bateria (cap. 10) [Song Midi] 
Enter    Enviar reprodução da música reservada 
Pause     Pausar Pausar / Reproduzir 
+     Aumentar em um semitom  
-     Diminuição de um semitom 

Pg. Up     Tempo aumentado [Song Midi e áudio] 
Pg. Down    Diminuir o tempo para baixo [Song Midi e áudio] 
Ctrl + +    Aumenta um semitom da música reservada 
Ctrl + -    Decremento de um semitom da música reservada 
Ctrl + Pg. Up    Aumento do tempo de atividade da música reservada [Midi e áudio] 
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Ctrl + Pg. Down   Decremento do tempo de inatividade da música reservada [Midi e áudio] 
Ctrl + M    Melody (Cap. 4) da música reservada Yes / No [Song Midi] 
Fim     Baixe a música reservada (STOP) 
Z     Modo de tela cheia 
Backspace    Abre a janela de pesquisa de músicas no SongList 
Guia    Rola entre as ocorrências de pesquisas no SongList 
S     Audio Sampler 
J     Pré-escutando 
E    mostrar / ocultar a barra de melodia 
Ctrl + Q / Ctrl + S   Virtual salva a música atual 
Ctrl + K    Ativar / Desativar o Monitor de Karaokê 
Ctrl + J    Ativar / Desativar o Clone Monitor 
,     Ativar / Desativar parte da bateria Fora dos tambores midi 
.     Ativar / desativar efeitos de percussão midi de percussão 
Shift + M    Ativar / Desativar qualquer segunda faixa associada 
Shift + Pg. Up    Aumentar o volume da música 
Shift + Pg. Down   Para baixo diminui o volume da música 
Shift + [F11]    Abre todo o database 
Home    Abrir lista de músicas 
Del     Solo se em markers de loop: Saia do loop 
Y     Somente se for Groove (midi ou audio) ele sairá do groove no final 
 
Tela de apresentação (Com o SongList aberto): 
Home / Home   Primeira coluna do SongList 
Fim     Última coluna da SongList  
Pesquisa inicial   pela primeira música com a inicial 
Space     Reserve a música e feche o SongList  
Ins     Insira a música na lista de músicas temporária (F10) 
Pg. Na                 primeira linha do SongList 
Pg. Down    Última linha do SongList 
Backspace    Pesquisar uma música 
Separador   Repetir pesquisa 
Enter / Return  Envie a reprodução da música e feche a lista de músicas 
Esc     Fecha a lista de músicas 
Del    Solo em F10: excluir da lista F10 
 
Pré-escuta 
Esc     Fecha sem salvar 
F     Próximo 
R     Voltar 
G     Se posiciona no ponto definido com J e faz uma pausa 
J     Defina a posição sem fechar a pré-audição 
H     Teste de posição sem fechar a pré-audição 
O     Início 
ENTER     Fecha salvando a posição atual 
SPACE    Área de pausa / reprodução pré-audição 
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Sampler de áudio 
\     Pare em todos os amostradores 
S     Abre / fecha e interrompe todos os amostradores 
1..2..3 ..... 0    Reprodução da amostra 
CTRL + 1..2..3 ..... 0   Selecione o conjunto 
 
Com pesquisa aberta 
Guia    Com pesquisa aberta 
Shift + F11    Abre todo o database para pesquisa 
Ctrl + T    Filtrar por título 
Ctrl + I     Filtrar por intérprete 
Ctrl + G    Filtrar por gênero 
Ctrl + C    Filtrar por artista / compositor 
Ctrl + D    Filtrar por ID 
Ctrl + B    Filtrar por hora ou intervalo de tempo (de-para) 
Ctrl + A    Tudo, sem filtro 
Esc     Fecha a janela de pesquisa 
 
No Database 
Ctrl + K    Ativar / Desativar o Monitor de Karaokê 
ENTER    Enviar reprodução da música 
Esc     Parada da música 
E     Edite a célula do database 
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(Mac Osx) 
Performance view (with the SongList closed): 
 
Spacebar    Opens the SongList or Pause / Play of the Song 
Arrow Keys    Opens the relevant SongList 
? + 2 digit number from 00 to 43 Opens the relative SongList (43 = the whole database) 
1..2..3 ........ 0    Play from the relevant Lessor or silent channel 
Shift + [1..0]    Book the relative Lessor 
Ctrl + [1..0]    Reserves the relative Marker of the booked Song 
Shift + Ctrl + [F1 .. F10]  Jumps to the relative Marker of the booked Song 
O     Play from the beginning of the song 
Q     Fade Out to the booked Song 
W     Change the size of the Karaoke text (small Med. Grd.) 
Shift + W    Change the text mode in the Main monitor 
Ctrl + W    Change the text mode in the karaoke monitor 
F     Next 
R     Back 
M     Melody (ch. 4) Yes / No [Song Midi] 
T     Restores the original Tempo [Song Midi] 
U     Solo Melody (Ch. 4) [Song Midi] 
N     Channels on / off as originally 
P     Talk Over (on key pressed) 
A     Activate all channels [Song Midi] 
K, L     Scroll for text in the lectern 
D     Drum only (Ch. 10) [Song Midi] 
C     Show / Hide chords 
Shift + C    Displays / Hides the Chords in the Karaoke Monitor 
Y     Mix with the booked Song 
Shift + Y    Manual Mixing (then press Y) of the booked song 
H     Scrolls through the mixing modes 
X     Opens the mixer 
I                   Opens the Mixer in Instruments mode (you can press the 1..0 and Q 

... Y keys for the On / Off tracks) 
V     Vocalist track (Ch. 16) Yes / No [Song Midi] 
B     Bass only (Ch. 2) and Drums (Ch. 10) [Song Midi] 
Enter    Send Play of the booked Song 
Pause     Pause / Play 
+     Increase by a semitone 
-     Decrease of a semitone 

Pg. Up     Tempo increase [Song Midi] 
Pg. Down    Tempo decrease [Song Midi] 
Ctrl + +    Increase a Semitone of the booked song [Song Midi] 
Ctrl + -    Decrement of a Semitone of the Booked song [Song Midi] 
Ctrl + Pg. Up    Tempo increase of the booked song [Song Midi] 
Ctrl + Pg. Down   Tempo Decrement of the booked Song [Midi Song] 
Ctrl + M    Melody (Ch. 4) of the booked song Yes / No [Song Midi] 
End     Stop the booked song (STOP) 
Z     Fullscreen mode 
Backspace    Opens the song search window in the SongList 
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Tab     Scrolls between occurrences of searches in the SongList 
S     Audio Sampler 
J     Pre Listening 
E    Show / Hide the Melody Bar 
Ctrl + Q / Ctrl + S   Virtual save current song 
Ctrl + K    Enable / Disable the Karaoke Monitor 
Ctrl + J    Enable / Disable the Clone Monitor 
,     Enable / Disable Drum Part Off midi drums 
.     Enable / Disable Drum Part Off midi percussion effects 
Shift + M    Enable / Disable any second associated track 
Shift + Pg. Up    Increase the Song Volume 
Shift + Pg. Down   Decreases the Song Volume 
Shift + [F11]    Open the whole database 
Home    Open Song List 
Del     Only if in loop Markers: Exit the loop 
Y     Only if it is Groove (midi or audio) does it exit the groove at the end 
 

 
 

Performance Display (With the SongList open): 
Home / Home   First column of the SongList 
End     Last column of the SongList 
Initial     Search for the first song with the initial 
Space     Book the Song and close the SongList 
Ins     Insert the Song into the Temporary Song List (F10) 
Pg. Up     First line of the SongList 
Pg. Down    Last line of the SongList 
Backspace    Search for a Song 
Tab     Repeat search 
Enter / Return  Play of the Song and close the SongList 
Esc     Close the SongList 
Del    Only in F10: delete from the F10 list 
 

 
Pre Listening 
Esc     Closes without saving 
F     Next 
R     Back 
G     It positions itself at the point set with J and pauses 
J     Set the position without closing the pre-listening 
H     Position test without closing pre-listening 
O     Start 
ENTER     Closes by saving the Current position 
SPACE    Pre-listening pause / play area 
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Audio Sampler 
\     Stop on all samplers 
S     Opens / closes and stops all samplers 
1..2..3 ..... 0    Play of the Sample 
CTRL + 1..2..3 ..... 0   Select the set 
 
Open search 
TAB    Search Song in the current SongList 
Shift + F11    Opens the entire database for research 
Ctrl + T    Filter by title 
Ctrl + I     Filter by interpreter 
Ctrl + G    Filter by Genre 
Ctrl + C    Filter by Artist / Composer 
Ctrl + D    Filter by ID 
Ctrl + B    Filter by Time or time range (from-to) 
Ctrl + A    All songs no filter 
Esc     Closes the search window 
 
In Database 
Ctrl + K    Enable / Disable the Karaoke Monitor 
ENER    Send Play of the Song 
Esc     Stop of the Song 
E     Edit the database cell 

 

Dicas: 
1) O Winlive é estruturado de tal forma que é possível gerenciar a maioria das funções durante a 
fase Performance, durante a apresentação em um show ou concerto, através do uso exclusivo do 
teclado do computador, evitando assim o inconveniente de ter que gerenciar o funciona com o 
uso do mouse, o que implica maior tempo de uso e desconcentração para o artista. 
2) É aconselhável manter uma impressão das teclas de atalho à mão, geralmente após algumas 
apresentações, o usuário tende a memorizar as teclas e o gerenciamento do programa se torna 
ainda mais simples e imediato. 
 
As opções 
O Winlive Pro oferece ao usuário a oportunidade de personalizar seu ambiente de trabalho 
ajustando parâmetros e opções. 
As Opções podem ser acessadas através do menu Ferramentas  Opções. 
 
Dicas: 
1) é possível a qualquer momento retornar às opções padrão originais escolhendo RESET; os 2 
caminhos do SongFolderList também serão eliminados; 
2) se o seu computador for muito antigo, você poderá acelerar a execução do Winlive escolhendo 
"USAR CONFIGURAÇÕES PARA REQUISITOS MÍNIMOS". Isso definirá as opções orientadas para a 
velocidade, em vez da qualidade gráfica.
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MENU DE OPÇÕES 
 
Opções gerais: 

 
Pare no final de cada música 
Desativa a reserva automática da próxima música na lista 
 
Parada da música, mesmo que reservada 
Desativa a reprodução automática de músicas, mesmo se reservada 
 
Próxima música aleatória 
Reservar aleatoriamente a próxima música 
 
Desativar início automático da música 
Cada música solicitada não inicia automaticamente, mas é iniciada com a tecla Enter 
 
Barra deslizante de melodia 
A barra de melodia, que pode ser acessada a partir do Perfomance CTRL + E, pode ser fixada em 
telas ou deslizando 
 
Veja os proprietários na barra Melody 
Como descrição 
 
Use indicadores de medida na barra Melody e na notação 
Durante a rolagem da barra Melody, é possível visualizar uma numeração progressiva da medição. 
 
Barra de melodia inferior ou superior 
Posicione a barra Melody ao executar em Perfomance 
Indicadores de melodia verticais, fixos na horizontal, na horizontal com altura 
Como descrição 
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Barra de melodia apenas na tela principal, apenas no monitor de Karaokê, nos dois 
Como descrição 
 
Mistura automática 
Modo de mixagem entre uma música e a próxima ou a reservada apenas áudio, áudio e midi, 
desativada 
 
Milissegundos de espera antes do início 
Defina o número de milissegundos que o programa aguardará antes de reproduzir a música 
 
Volume da conversa 
Ao pressionar a tecla "P" durante a apresentação, o nível do volume cai para a porcentagem 
escolhida, permitindo que você fale enquanto a música está tocando em segundo plano 
 
Teclado do tablet 
Permite posicionar o teclado virtual (adequado para dispositivos Tablet) à direita, esquerda ou 
desativá-lo 
 
Chaves 1,2, ..., 0 
Você pode usar as teclas numéricas para acessar rapidamente os markers ou silenciar as faixas de 
1 a 10 
 
Use o espaço para a barra 
Você pode usar a barra de espaço para reproduzir ou pausar uma música ou mostrar ou ocultar o 
SongList 
 
Posição da janela de pesquisa 
Permite mover a janela "Pesquisar música" para cima ou para baixo na tela 
 
Use ESC duas vezes para parar em vez de ESC 
Se marcado, a parada será feita pressionando ESC duas vezes em vez de uma vez 
 
Ver relógio 
Ver um relógio no canto superior direito 
 
Use indicações de alto contraste 
Como descrição. Requer reiniciar o programa 
 
Não use leds 
Os LEDs estão posicionados e estão ativos em correspondência com os vários instrumentos 
exibidos na interface do Mixer; marcando esta caixa, eles são desativados. 
 
Não use o medidor VU para midi 
O Vu-Meter está ativo na interface Mixer para sinalizar o nível de som e pode ser desativado 
marcando a caixa apropriada. 
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Música final do CountDown piscando 
A contagem regressiva está presente no centro superior da tela de apresentação e pisca alguns 
segundos antes do final da música sendo reproduzida; removendo a seleção na caixa apropriada, 
você pode cancelá-la 
 
Ocultar automaticamente o teclado do Tablet 
Ao marcar a caixa apropriada, o teclado do tablet pode ser oculto 
 
Música reservada no monitor de karaokê 
Opção para exibir ou não a música reservada no monitor de karaokê, também dimensionando o 
caractere de exibição 
 
Informações principais e título do karaokê 
Opção para visualizar a música que está sendo tocada e seu tom no monitor de karaokê, também 
dimensionando o caractere de exibição 
 
Língua 
Escolha do idioma preferido. 
 
CONFIGURAÇÕES AVANÇADAS 
(É recomendável não alterar as configurações padrão, a menos que você seja um usuário 
experiente) 
 
Buffer Duplo de Tela 

Use um buffer graficamente duplo para reduzir a tremulação e melhorar a qualidade gráfica. 
(Talvez seja necessário reiniciar o Winlive para que a alteração entre em vigor) 
Use-o apenas em computadores com uma boa placa gráfica dedicada. 
 
Verifique se há atualizações na inicialização 
Se marcado, ele permite que você verifique automaticamente atualizações sempre que iniciar. 
 
Atualização da interface 
Cada tot de milissegundos o Winlive atualiza a interface gráfica. 

Ativar salto de quadro 
A mistura de dois vídeos atrasa a exibição da imagem do vídeo a seguir 
É marcado para economizar recursos em computadores com Perfomance inferior 
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Midi 1 opções: 

 

Device Midi 
É possível configurar um dispositivo para o Midi tanto físico (expansor, teclado) quanto virtual 
(Roland VSC, Miscrosoft SoftSynth, etc.). 
O botão Atualizar atualiza a lista se você acabou de conectar um novo dispositivo. 
 
Use o WSE (Winlive Synth Engine) 
Esse recurso permite que você use o banco de som digital do Winlive Pro Synth 10 sem ficar preso 
a expansores externos. 
 
Fora 
Saída padrão para a saída do fluxo Midi 
... 
Ele permite que você selecione outro banco de som digital instalado no seu PC através de um 
simples explorador de recursos. E com o X cancela 
 
Midi Out + WSE 
Ele permite que você use o Winlive Synth Engine com uma saída midi para ser selecionada em 
dispositivos midi. 
 
Começo a partir da primeira nota 
Se marcado, permite que você se posicione diretamente na primeira nota útil ao abrir o arquivo 
Midi, permitindo acesso imediato. 
 
Pare no último NOTE-OFF 
Se marcado, permite que você termine a música no último NOTE-OFF, truncando qualquer parte 
do som.  
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Midi acompanha Vol% (1-100) 
Permite a variação do volume geral das faixas midi em porcentagem. 
Compressão Midifile 
Permite a compactação da dinâmica de anotações de arquivos midi de acordo com os valores 
mínimo e máximo definidos abaixo. 
 
Midi melody channel 
Define o canal midi da melodia (como padrão definido no canal midi 4) 
 
Metrônomo do dispositivo 
É possível definir um dispositivo diferente para o metrônomo ou usar o mesmo dispositivo 
principal. 
Aviso: o uso de um dispositivo diferente para o metrônomo pode causar problemas de tempo, 
devido a diferentes latências do dispositivo midi usado. 
 
Medidas iniciais com metrônom 
O metrônomo será reproduzido até o número de batidas escolhido após o qual é desligado 
automaticamente (é conveniente usar esta função juntamente com a desmarcação da partida da 
primeira nota). 
 
Sons do metrônomo 
Esta parte do menu permite alterar o som do metrônomo e definir o volume dele. 
 
Compensação de metrônomo 
É usado para "calibrar" o metrônomo se houver problemas de latência 
Na janela suspensa abaixo, você pode determinar se o metrônomo é midi ou audio 
 
Markers midi para batting 
Marcadores no modo de medidas  
Conforme descrição 
 
Entrada Midi 
Permite a conexão de um teclado ou de qualquer dispositivo MIDI IN para reproduzir 
externamente os sons internos do WINLIVE. 
 
Ignorar leitura de faixas Midi 
Ignore a leitura de parâmetros que não sejam note on e note off da faixa selecionada para 
arquivos midi, se desativada, ela será desativada. 
 
Sensibilidade do teclado 
Ajusta a sensibilidade ao toque no teclado midi possivelmente atribuído na entrada midi. 
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Midi 2 opções: 
 

 
 
Temporizador de resolução  

As mensagens midi são enviadas em massa a cada tot milissegundos. Geralmente 10 
milissegundos é a resolução ideal. 
Um aumento no timer diminui a carga da CPU, mas pode entupir o dispositivo Midi, uma 
diminuição distribui melhor as mensagens midi, mas pode pesar em CPUs lentas. 
Em geral, o intervalo de trabalho padrão dentro do qual o tempo é perceptivelmente preciso varia 
de 5 a 30 milissegundos. 

 
Midi Engine Multitarefa 
O mecanismo midi multitarefa permite a execução de vários fluxos midi simultaneamente, 
aumentando a velocidade de carregamento e execução, excelente para computadores com bom 
Perfomance. 
 
Filtrar mensagens não GM-GS 

Deixe de fora os eventos midi redundantes considerados inúteis para a reprodução de 
arquivos Midi como Control Change etc ... 
Alguns dispositivos com funções avançadas, como saída de karaokê ou vocalista, em combinação 
com algumas songs específicas, podem precisar enviar essas mensagens. 
Desmarque-o somente se você encontrar esses problemas. 

Carga leve 
Deixe de fora alguns eventos midi como Pitch-bend, AfterTouch etc ... 
Habilite-o apenas se você tiver lentidão na reprodução Midi. 
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Notas Parcial desativado 
Uma maneira alternativa de usar a redefinição da alteração de afinação, pausada e no final da 
música. 
Não o habilite se você usar um expansor, caso contrário, as notas se deteriorarão muito 
lentamente 
 
Enviar Reset Sysex antes da música  
Envie a mensagem de redefinição padrão do Sysex antes de cada música midi, o tipo de 
mensagem de redefinição (GM, GS etc.) pode ser escolhido no menu suspenso logo abaixo. 
As alterações no programa começam em 1 
Por convenção, as alterações do programa exibidas podem começar de 1 em vez de 0 (apenas 
para indicação visual) 
 
Compatibilidade da bateria M-live Xlight 
Exclua alguns kits de bateria que podem bloquear o M-live xlight e o M-live Xlight 2; não selecione 
se você usa dispositivos midi que não sejam os dois listados acima. 
 
Ignorar mensagens de redefinição de Sysex 
Ignore as mensagens padrão de redefinição sysex já incluídas no arquivo midi. 
 
Ms esperando antes da primeira nota 
Indica o tempo de espera em milissegundos antes de iniciar o midifile 
Esse modo é útil para expansores mais antigos que precisam de um tempo de espera para 
gerenciar o fluxo de dados midi recebidos da maneira ideal. 
 
Enviar mensagens SysEx 
Habilite o envio de mensagens SysEx contidas no arquivo midi durante a reprodução. 
Exemplo: se a música contiver 2 faixas de bateria, é necessário habilitar a leitura da mensagem 
SysEx correspondente indicando para o dispositivo midi que a faixa 9 ou 11 é um kit de bateria. 
 
Envie mensagens SysEx antes do início 
Envie uma série de comandos do SysEx antes do início de cada música. Muito útil para expansores 
mais antigos que usam instruções não padrão. 
 
Exemplo: para enviar a redefinição do GM, desative a opção "Enviar redefinição do GS" e cole a 
seguinte string em "Enviar mensagens do SysEx antes de iniciar": 
                                                                             F0 7E 7F 09 01 F7 
 
Para o XG de redefinição, cole a seguinte string: 
                                                                      F0 43 10 4C 00 00 7E 00 F7 
É possível optar por endereçar as mensagens SysEx apenas ao dispositivo Midi principal ou a todos 
os dispositivos. 
 
Otimização de fluxo 
Para otimizar o fluxo de dados enquanto reproduz o midi, é recomendável não desativá-lo. 
 
Enviar alteração de programa e N / RPN em redundância durante salto 
Conforme descrição 
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Tempo de Sysex 
Defina o tempo de atraso após o envio de uma mensagem sysex para o dispositivo. 
 
 
Permitir várias saídas midi 
Ele permite o uso de várias saídas midi quando você deseja gerenciar vários dispositivos para a 
mesma base. 
Consulte o Mixer em Perfomance 
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Opções de áudio: 
 

 
 
Dispositivo de áudio 
É possível configurar um dispositivo para a saída de áudio (Áudio e Vídeo), normalmente uma 
placa de som. 
O botão Atualizar atualiza a lista se você acabou de conectar um novo dispositivo. 
 
Usar dispositivo secundário (pré-escuta) 
É possível configurar um segundo dispositivo para usar a funcionalidade de pré-audição, 
geralmente uma placa de som. 
 
Segunda saída de áudio do dispositivo 
É possível definir uma segunda saída de áudio para a segunda faixa de áudio 
 
Salto FF (segundos) 
Estes são os segundos de salto em que o avanço rápido do FastForward é selecionado em uma 

base de áudio, botão,  ('F').
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Corte o silêncio inicial 
Se marcado, permite a execução de arquivos de áudio iniciando diretamente a partir da primeira 
parte audível. É útil verificar se você deseja execução imediata, mesmo para faixas de áudio, 
especialmente CDGs que às vezes contêm uma parte silenciosa no início que pode durar até mais 
de 10 segundos. 
 
Carregamento rápido 
Capacidade de carregar em tempo real, ainda mais rápido em arquivos de áudio. 
O aumento da velocidade não é muito evidente, já que o Winlive já é muito rápido de uma 
maneira normal. Recomendamos que você ative essa opção apenas se realmente precisar 
reproduzir as faixas de acompanhamento em tempo real, pois isso pode reduzir a qualidade da 
transposição em algumas placas de som. 
 
Pré-carregamento de áudio 
Se marcada, esta opção permite carregar a base de áudio na memória no momento da reserva, 
para que, quando reproduzida, a base comece mais rápido. 
 
Pré-carregamento do MultiTask 
Permite alterar o tempo sem distorcer a base. 
 
Mudança de tempo sem distorção 
Permite alterar o tempo sem distorcer a base. 
 
Compressão de volumes 
Habilite a compactação de volume no áudio, para obter detalhes, vá em Ferramentas -> Opções de 
áudio do Winlive. 
 
Ativar ganho 
Habilite o uso de ganho no Mixer virtual. 
 
Buffer de áudio 
Defina o tamanho do buffer. Aumente esse parâmetro apenas se forem ouvidas interrupções ao 
reproduzir arquivos de áudio e vídeo. Não é recomendável diminuir a partir do valor padrão. 
 
Aparecimento gradual 
Defina o fade IN possível fixo para songs de áudio (tempo expresso em milissegundos). 
 
Desaparecer 
Defina qualquer fade OUT fixado para as songs de áudio (tempo expresso em milissegundos).
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 Karaokê e fotos: 

 
 
Nesta tela, você pode alterar o tema gráfico do programa, a imagem de plano de fundo, 
personalizar as cores do texto e do plano de fundo, além do caráter do Karaokê e muito mais. 
 
Tema 
Permite selecionar um tema gráfico para o Winlive. 
O tema afeta o plano de fundo e a cor do texto, o preenchimento e as sombras ou efeitos 
 
Usar imagem de fundo 
Se marcado, corresponde por padrão à imagem de plano de fundo do tema para todas as 
execuções.  
 
Imagens aleatórias de uma pasta 
É possível selecionar uma pasta na qual o Winlive carrega imagens aleatoriamente e as associa a 
cada música. 
 
Cores personalizadas 
Permite a personalização de cores para texto, preenchimento e assim por diante 
Por linha extra, queremos dizer as linhas extras após o texto em execução 
 
Cor de fundo 
Na ausência de uma imagem de fundo, é possível alterar a cor do fundo 
 
Fonte 
É possível estabelecer um caractere comum a todos os modos de exibição de texto 
 
Modo principal de karaokê 
Eu venho sete modos e parâmetros para exibir o texto no monitor principal 
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Também é possível melhorar a qualidade gráfica do karaokê (não recomendado para 
computadores "lentos") 
 
Monitorar o plano de fundo 
Permite personalizar o plano de fundo do monitor principal e do monitor de karaokê. 
 
Monitorar banner 
Permite inserir um banner no monitor de karaokê 
 
Nunca ocultar o papel de parede do monitor 
Como descrição 
 
Exibir logotipo no monitor de karaokê 
Na ausência do tique, ele não exibe o logotipo WINLIVE no centro do Karaoke Monitor 
No logotipo do WINLIVE X, no canto superior direito do monitor de karaokê, ele sempre é exibido 
 
Visualizando Imagens ou Arquivos PDF 
É possível decidir onde exibir imagens ou PDFs (partituras ou imagens) com várias possibilidades 
de visualização 
 
Texto de adiamento - Adiamento 
Possibilidade de antecipar ou adiar para um número selecionado de milissegundos a rolagem do 
texto em relação à configuração no arquivo Midi ou no Mp3. 
 
Barra de início de canto 
Possibilidade de exibir a barra de início no monitor de karaokê e no monitor principal e, se 
presente no monitor principal, é possível movê-lo na barra de status em vez de no espaço 
reservado para o texto 
 
Indicador de bola quicando  
Exibe uma animação na linha ou sílaba do texto de rolagem do karaokê. 
Nos arquivos Midi, ele muda de cor no ritmo do metrônomo. 
 
Precedência de codificação M-live (serviço de música) em vez de karaokê 
Existem songs midi que podem ter mais de uma codificação para o texto / acordes, por exemplo, 
formato sysex e formato 1000. texto limpe esta função. 
 
Permitir sincronização de texto e acordes em arquivos wave 
Capacidade de inserir letras e acordes em arquivos de áudio 
 
Otimize automaticamente o karaokê para mp3 
O texto mp3 é otimizado para uma exibição mais legível 
 
Otimizar o karaokê midi 
O texto nos arquivos midi é otimizado 
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Songlist:

 
 
Tipo de classificação SongList 
É possível escolher a ordem de classificação para todas as listas de músicas 
ID = pedido de inserção, o último inserido irá para o final 
TITLE = por título, INTERPRETER = por intérprete, AUTHOR = por autor, 
GENRE_NOTES = para o gênero da música ou para as anotações relativas 
TYPE = por tipo de música (por exemplo, midi, mp3, vídeo etc.) 
A ordem de classificação do SongList também pode ser selecionada combinando campos 
diferentes. 
Você pode usar o campo Pedido, que permite fazer uma classificação personalizada das listas, 
conforme definido no database 
Para uma classificação específica para cada SongList, consulte a função do editor SongList na voz 
do instrumento. 
 
Células SongList 
Permite definir o número de colunas a serem exibidas no SongList. 
 
Colunas SongList 
Permite definir o número de colunas a serem exibidas no SongList. 
 
Tamanho da fonte / célula SongList 
Ele permite que você defina o tamanho da fonte nas células de todas as listas de músicas.. 
 
Número de caracteres por célula 
É usado para definir o número máximo de caracteres que cada célula deve ter. 
 
Posição SongList 
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Você pode visualizar o SongList na parte inferior, esquerda ou direita 
 
Gerenciar campo de intérprete / autor / hora etc. 
Intérprete à direita do título 
Permite escolher onde colocar o intérprete de uma música. 
 
Digitando no SongList 
Ele permite que você faça uma pesquisa rápida pelo teclado, permitindo escolher a pesquisa como 
a primeira letra, a pesquisa inteligente no início e a pesquisa inteligente em todo o nome. 
 
Estilo da grade 
Permite ajustar a borda das células de todas as listas de músicas. 
 
Estilo de texto 
Permite ajustar a evidência do texto nas listas de músicas. 
 
Cores do SongList 
Permite a variação das cores exibidas no SongList, atribuindo uma cor diferente para cada tipo de 
arquivo, bem como para o plano de fundo e a seleção. 
 
Destacar arquivos Arquivos ausentes no SongList 
Essa importante função identifica arquivos Arquivos ausentes, ou seja, arquivos cujo caminho não 
corresponde ao do database. Se os arquivos estiverem "escuros", significa que eles não são 
executáveis 
 
Fonte SongList 
Permite o ajuste de caracteres dentro do SongList. 
 
SongList no Karaoke Monitor 
Também permite visualizar o SongList no segundo monitor. 
 
SongList no Karaoke Monito 
Veja a SongList também no Karaoke Monitor. 
 
Canção concluída  
Colora todas as músicas já tocadas. 
 
Pré-carregue as listas de músicas 
Pré-carregamento do SongList aumentando a velocidade de exibição do mesmo 
 
Não oculte o SongList no final da música 
No final de cada música, o SongList permanece ativo mesmo se não houver "cadeado fechado" 
 
Denunciar música com acordes de Karaokê / 'K' 
Sinaliza a presença do texto ou acordos através da letra K 
 
Use a roda do mouse para rolar  
A roda do mouse está ativada para rolar pelas músicas do SongList em performance 
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Acordes e textos: 

 
 
Notação de acordes 
Permite que você mantenha a notação inalterada ou converta todos os acordes que possam estar 
contidos nos arquivos no formato italiano (Do-Re-Mi ..) ou no formato anglo-saxão (C-D-E ..) 
 
Excluir revolta de graves 
Se ativo, exibe os contratos excluindo o endereço, se houver. 
Exemplo: Gsus / C será exibido como Gsus 
 
Transponha acordes com base na transposição 
Se ativo, a transposição de acordes segue a alteração de afinação da base (áudio ou midi). Se 
desativado, mantenha os acordes inalterados quando a alteração de afinação for realizada. 
 
Leia o formato CC # 1, GENERALMUSIC  
Permite a leitura de acordes em formatos específicos. É possível ativar esta opção que 
informações diferentes de acordos sejam lidas no campo de acordes. 
  
Varredura avançada de acordes CC # 1 
Permite a leitura de acordes "avançados" no formato CC # 1 
 
Preenchimento e texto sem formatação 
É possível alterar a cor dos acordes nas letras (modo Atril com acordes), útil para diferenciar o 
texto do karaokê dos acordes. 
 
Otimize a posição dos acordes no texto sempre que possível 
Conforme descrição 
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Chord Bar 
Permite definir a dimensão da altura da barra de acordes. 
 
Barra de acordes deslizante 
Permite que a barra de acordes deslize junto com a base. 
 
Número de células na barra de acordes 
Permite escolher o número de células dentro da barra de acordes 
 
Acordes na barra de melodia 
Permite que os acordes sejam inseridos na barra de melodia 
 
Cores da barra de acordes 
Escolha de cores para a barra de acordes 
 
Acordes automáticos (midifile) 
Capacidade de calcular automaticamente acordes em arquivos midi com várias opções 
 
Veja Txt e Rtf também no Karaoke Monitor 
Se marcado, permite que o texto seja exibido mesmo dentro do Karaoke Monitor 
 
Fonte TXT 
Permite alterar a fonte, a cor e o tamanho do texto além do plano de fundo. 
Também é possível centralizar o texto TXT e o texto RTF 
 
Rolagem automática de texto 
Ao associar um texto (txt ou rtf) a um arquivo, podemos decidir a velocidade de rolagem do texto. 
Lembre-se de que você pode usar as teclas K e L para avançar ou retroceder no texto. 
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CDG / Vídeo (somente usuários experientes) 

 
 
É bom interagir com esses parâmetros apenas se você estiver totalmente ciente da estrutura e das 
características dos arquivos Mp3 + CDG (Karaoke Gráfico). 
 
CDG (usuários especializados) 
 
Histórico pessoal no CDG 
Se ativado, use a cor atual do plano de fundo em vez da cor original do CDG. 
 
Use a placa no GDG 
Ative a coloração da borda no CDG, quando disponível. 
A desativação, por padrão, permite uma melhoria na reprodução de CDGs no computador que não 
precisa de uma borda como na TV. 
 
Viés-Cor 
Você pode ajustar a gama de cores RGB (vermelho, verde, azul); valores mais altos resultam em 
maior brilho para a respectiva gama de cores. 
 
ARQUIVOS DE VÍDEO 
Video Engine 
Selecione o "mecanismo" de vídeo para ler os arquivos 
 
Atraso de áudio 
Estabelece o atraso do áudio comparado ao vídeo. É usado quando não há sincronia perfeita entre 
vídeo e áudio 
Arquivos de vídeo apenas no monitor Karaoke 
O arquivo de vídeo será carregado apenas no monitor de Karaokê, enquanto no monitor principal 
haverá o texto Karaokê. 
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Não use vídeos no monitor de karaokê 
Ativando esta função, o vídeo não será exibido no monitor de Karaokê, diminuindo o tempo de 
carregamento do vídeo. 
 
Manter proporção 
Mantenha o tamanho do vídeo igual ao tamanho original. 
 
Vídeo associado em loop 
A associação de um arquivo de vídeo nesta função permitirá a reprodução em segundo plano 
continuamente (loop) 
 
Texto no vídeo 
Atualmente, não é possível exibir o texto em um vídeo, mas ele pode ser posicionado acima ou 
abaixo do vídeo, apenas no monitor de karaokê ou nos dois monitores. 
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OPERAÇÕES SOBRE AS OPÇÕES 
 
• PARA APLICAR AS OPÇÕES É NECESSÁRIO CLICAR EM "APLICAR" 
• PARA SAIR DA TELA DEIXANDO AS MODIFICAÇÕES, CLIQUE EM "CANCELAR" 
 
Com IMPORT, você pode importar opções de configuração de um computador para outro, 
exportando-as com EXPORT 
Com RESET, as configurações "de fábrica" são restauradas 
USE CONFIGURAÇÕES PARA REQUISITOS MÍNIMOS para definir as opções mínimas compatíveis 
com computadores com desempenho inferior 
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APÊNDICE 

Especificações e compatibilidade 

Funzione Caratteristica 

Compatibilidade de arquivos: 
midi, kar, mp3, wav, cdg, cdg-zip, avi, mpg, mp4, flv, wma, 
lrc, txt, rtf, jpg, gif, bmp, ytb YouTube, pdf 

Compatibilidade com o formato Midi: Tipo 0, Tipo1, Smf 16 tracce 

Compatibilidade de texto: 
Tune1000, M-live, Solton, TextInKar, MP3TagV2, MP3 M-
liveText 

Modo de redefinição: 
GS, garante total compatibilidade com a maioria das songs 
midi 

Número máximo de músicas na lista: 120.000 

Número máximo de músicas no 
database: 

 > 200.000 

Tempo médio de acesso à música: 0.05 - 0.2 sec. calculated on 2Gzh, 2GB ram 

Número de sons predefinidos: 333 Instruments * + 27 DrumKit * + 32 User Sounds 

 

O mecanismo midi foi redesenhado do zero em comparação com todas as versões anteriores do 
Winlive, portanto, pequenas diferenças na reprodução podem ser notadas. 

Agora, o gerenciamento do midi ocorre totalmente no MultiTasking em um processo 
independente, pelo qual agora é possível abrir janelas e continuar trabalhando e abrir programas, 
reduzindo o Winlive a um ícone mesmo durante a execução de um arquivo Midi sem incorrer em 
lentidão e perda de tempo no midi . 

* Na realidade, os sons midi que podem ser usados são mais, mas por convenção o nome do 
primeiro banco é sempre exibido no programa enviado (por exemplo, para Hard FM Piano 
bank024-pc: 006, o nome ELECTRIC PIANO 2 bank será exibido: 000- pc006) se, no entanto, o 
dispositivo estiver ativado para reproduzir esse som, ele usará o som correto.



 81

NOTICIAS LEGAIS 

Licença de usuário Winlive Pro (ITA) 
 
LEIA ESTE DOCUMENTO COM ATENÇÃO ANTES DE ABRIR O PACOTE. 
O PROGRAMA INCLUÍDO NESTE DISCO É LICENCIADO AO USUÁRIO. VOCÊ CONCORDA EM CUMPRIR OS 
TERMOS DESTA LICENÇA DE USO. AVISO: ESTE PROGRAMA É PROTEGIDO PELAS LEIS DE DIREITOS 
AUTORAIS E TRATADOS INTERNACIONAIS. O PRODUTO DE SOFTWARE É LICENCIADO, NÃO É VENDIDO. A 
REPRODUÇÃO OU DISTRIBUIÇÃO NÃO AUTORIZADA DESTE PROGRAMA, OU PARTE DO SEU, PODE 
RESULTAR EM PENALIDADES CRIMINAIS E CIVIS. 
 
1 - Direitos do usuário 
O SOFTWARE PRO MUSIC concede ao usuário final o direito de usar uma cópia do programa de software 
conectado em um único computador. O Software está "em uso" em um computador quando é carregado 
na memória temporária (RAM) ou instalado na memória permanente (por exemplo, disco rígido, CD-ROM 
ou outro meio de armazenamento) desse computador. 
 
2 - Direitos autorais 
O software é de propriedade do PRO MUSIC SOFTWARE e está protegido pelas leis de direitos autorais em 
vigor na Itália; por disposições e tratados internacionais e por todas as outras leis nacionais aplicáveis. Em 
qualquer caso, o usuário não pode reproduzir o manual ou parte dele e o material escrito que acompanha o 
Software. 
 
3 - Limites da garantia 
O SOFTWARE PRO MUSIC garante que o Software funcionará em conformidade substancial com o manual. 
Para proteger o usuário, será possível solicitar uma nova ativação (até um máximo de 4 no total) em caso 
de alteração do computador após a desinstalação do programa anterior ou em caso de roubo, perda ou 
formatação do computador. 
 
4 - Limites de responsabilidade 
Em nenhum caso a PRO MUSIC SOFTWARE pode ser responsabilizada por danos (incluindo, sem limitação: 
danos causados por perda ou perda de ganhos, interrupção de negócios, perda de informações, multas ou 
outras perdas econômicas) decorrentes do uso ou da incapacidade de fazer uso do Software, mesmo que o 
SOFTWARE PRO MUSIC tenha sido avisado da possibilidade de tais danos. 
 
5 - Instalação 
O Winlive Pro usa um pacote de instalação com instalação automática 
No momento da instalação, será possível escolher o caminho da instalação e outros parâmetros. Observe 
que as entradas do registro e as configurações do sistema podem ser alteradas para permitir a correta 
operação do próprio programa. 
 
6 - Outras restrições 
A instalação nesta versão Pro é redistribuível como está. É proibida a reprodução, mesmo a distribuição 
parcial e parcial dos arquivos individuais gerados pela Instalação. ASSISTÊNCIA REMOTA GRATUITA 
(usuários das versões WINLIVE PRO 10 / WINLIVE PRO SYNTH 10) e YOUTUBE SERVICE até fevereiro de 2021 
são garantidos
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